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GETTING STARTED 

DOWNLOADING AND INSTALLING 
Download ActiLife 7 from  https://actilife.theactigraph.com/support/getactilifebykey/ to a known location.  
Double-click the icon to start the installer.  After running the ActiLife installer, follow the installation instructions in 
the on-screen prompts.   

 
FIGURE 1 – ACTILIFE SETUP ICON 

IMPORTANT: Please be sure to remove any ActiGraph devices that you have 
connected to your computer during installation.  Failure to do so could result 
in a faulty installation of your ActiLife software. 

 

NOTE: Older versions of ActiLife (5 and 6) will be removed whenever ActiLife 7 
is installed 

After installing ActiLife, an icon similar to the one shown here will appear on your desktop.  Double-click the icon 
to start ActiLife 7. 

 
FIGURE 2 – ACTILIFE 7 PROGRAM DESKTOP SHORTCUT 

LICENSING 
ActiLife software is a licensed program and requires users to obtain a product key before the software can be 
activated.  If you have not purchased an ActiLife license, you may do so by requesting a quote at 
https://theactigraph.com/academic-research#actilife.  If you have misplaced your product key, contact ActiGraph 
support at support@theactigraph.com in order to proceed.   Once ActiLife 7 has been purchased or upgraded from 
a previous version, users are entitled to free updates for 12 months.  After that period, an optional maintenance 
plan may be purchased.  It is highly recommended that users purchase the maintenance plan in order to 
guarantee access to the newest updates, features, and bug fixes. 
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ACTIVATION OVER THE INTERNET 
The first time the program is launched, users will be presented with a screen similar to that shown in Figure 3.  If 
you have already received a product key for your ActiLife Full or ActiLife Lite software, type that product key in the 
box provided.  If the license formatting is correct, a green check mark will appear to the right of the license box.  
Click “Activate”.  ActiLife will connect to ActiGraph’s license server to confirm that the product key is correct and 
that it has indeed been purchased or upgraded.  After activation, a screen similar to the one shown in Figure 4 will 
be displayed.  This screen summarizes the product type and the number of activations used and available, as well 
as the name and contact information of the person to whom the license is registered.  Name, Email, and 
Organization fields must be populated in order to continue.  This activation process is required for each computer 
on which ActiLife is running. 

 
FIGURE 3 – ACTILIFE ACTIVATION SCREEN 
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FIGURE 4 – ACTILIFE REGISTRATION CONFIRMATION 

ACTIVATION WITHOUT AN INTERNET CONNECTION 
For users without an internet connection, ActiLife can be activated by contacting our technical support staff either 
via email (support@theactigraph.com) or by phone (1-877-497-6996).  Similar to the Internet activation, enter the 
ActiLife product key in the first box that appears after launching the program.  After clicking “Continue,” a screen 
similar to Figure 5 will appear.  Provide the 24-character product key to ActiGraph customer service 
representative.  After validating the product key, the representative will provide a confirmation code.  Type or 
copy/paste the confirmation code into the box provided.  Click ‘Next’ to activate ActiLife. 

 

 

FIGURE 5 – NON-INTERNET ACTIVATION 
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ACTILIFE NEW FEATURE OVERVIEW 
Each release (update) of ActiLife provides users with a new feature overview.  This screen (or similar) will appear 
immediately after loading ActiLife 7 for the first time.  Note that this screen will change with each release to 
quickly illustrate the new features. 

 
FIGURE 6 – ACTILIFE WELCOME SCREEN 

To view this welcome screen again at any time, select the ‘Help’ tab in the menu bar and then select ‘ActiLife Tour’ 
as shown in Figure 7. 

 

 
FIGURE 7 – RUN TOUR FROM HELP MENU 

ACTILIFE DEFAULT UNITS SELECTION 
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On first load, ActiLife gives users the option to choose which default units of measurement, time display format, 
and download directory they wish to use (see Figure 8).  These settings can be changed at any time from the 
Options menu. 

 
FIGURE 8 - DEFAULT UNITS SETTINGS ON FIRST LOAD 

 

ACTILIFE DATA FORMATS 
ActiLife stores and uses data from native *.agd files which are produced during the download or export process for 
all devices.  ActiLife can import data from any legacy file formats by selecting “File->Import/Export/Convert” and 
selecting the appropriate action from the menu (see the ActiLife Main Menu discussion section in this manual).  
Multiple files can be imported simultaneously. 

ACTILIFE MAIN MENU 

FILE MENU 
The file menu in ActiLife contains options related to file manipulation, AGD file analysis, and template loading and 
editing. 
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FIGURE 9 – ACTILIFE FILE MENU 

IMPORT/EXPORT 
As discussed previously, users can import and export file formats to various formats to meet nearly any need.  For 
details about the various file formats, see details in Appendix A – File Types in ActiLife.  The table below explains 
the Import/Export options that are shown in Figure 10.   

Epoch to Epoch 

 Imported files in this category contain epoch level data (e.g., 1s, 5s, 10s, 30s, 60s 
epochs). 

 Exported files also contain epoch level data in the new file format. 
 CSV->AGD conversion will convert both regular CSV files and Data Table CSV files. 
 Use these options to simply switch file types (file extensions). 

Raw to Epoch 

 Imported files in this category contain raw, 30Hz data or contain binary compressed 
data (*.gt3x format).  Note, 12Hz import files are not allowed.  See Uncompressing 
*.gt3x Files for details.  

 Imported files in this category contain raw agsd binary file format. 
 *.DAT files are file types used in ActiLife version 7. 
 Exported files in this category contain epoch level data (e.g., 1s, 5s, 10s, 30s, 60s 

epochs). 
 Exported files are first filtered then accumulated 
 Supported export file formats include .CSV, .AGD, .DAT 

Raw to Raw 

 Used to export binary*.gt3x files directly to *.csv format 
 Used to export binary*.agsd files directly to *.csv format 
 Both import and export file formats contain raw data at whatever frequency was 

used to produce the *.gt3x file or the *.agsd file 

Reintegrate 

 This feature is used to reintegrate epoch level post-filtered/post-accumulated *.agd 
files into larger epoch “buckets.”   

 E.g., reintegrating a 10s epoch file into a 60s epoch file. 
 Files cannot be reintegrated into smaller epoch lengths (e.g., 15s -> 10s) 

Misc 

 Heart Rate R-R. Exports HR data from .agd files containing HR information. 
 Proximity Tagging. Exports proximity tagging file in .csv format from selected .agd 

file(s). 
 IMU. Exports GT9X Link IMU data in .csv format from selected .gt3x file(s). 
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FIGURE 10 – ACTILIFE IMPORT/EXPORT MENU OPTION 

CONVERTING TO A DATA TABLE VS. STANDARD .CSV 
A data table *.csv file contains separate columns with corresponding headers for each data type collected by the 
device and also includes the Vector Magnitude sum of each axis if data is collected for all three axes.  A standard 
*.csv file produced during conversion simply exports the data into *.csv format.  Column headers are not included 
unless that option is by checking “Add Column Headers to CSV” in the options menu. 

MATLAB EXPORT OPTION 
Users can export native *.AGD files to *.MAT format for easy importing into MathWorks Matlab® mathematical 
software platform. 

RE-INTEGRATING 
The “Re-Integrate AGD File” option allows users to integrate AGD files to larger epoch periods (e.g., 1 second 
epoch data collection reintegrated to 60 second epoch periods for Sleep Analysis or Data Scoring).  After selecting 
the file to be reintegrated, selected the desired epoch length as shown and click “OK.”  The new file will be saved 
in the same directory as the existing file with an appended file name indicating the new epoch length. 
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FIGURE 11 – RE-INTEGRATION OPTION 

AGD FILE VIEWER 
The AGD File Viewer can be accessed from the File menu, by clicking “finished downloading” from the Devices grid 
after a download, or by double-clicking on an *.agd file from within Windows Explorer. 

Using the AGD viewer, users can instantly view the data they’ve just downloaded.  With ActiLife 6.1 and later, the 
AGD viewer provides a graphical summary view of both activity cut points (according to the stored cut points in 
ActiLife) or daily activity counts which allow users to make quick observations about the subject’s compliance level 
(see Figure 12Figure 12).  

 

FIGURE 12 - AGD FILE VIEWER (SHOWING CUT POINTS OR DAILY COUNTS) 
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Click “Edit” near the “Subject Biometric Information” section to edit the stored biometric variables associated with 
the *.agd file.   Click “Save” to instantly update the file with these changes. 

 

FIGURE 13 - EDIT SUBJECT BIOMETRICS FROM AGD VIEWER 

Clicking “Show Data” in the AGD viewer will display hour-long previews of the data in a grid format.  The hourly 
view can be changed by clicking the desired date/hour or by clicking “Next Hour->” to proceed sequentially 
through the hourly view.  Data can be copied from the grid by selecting the data and pressing “Ctrl+C.”  Data can 
then be pasted by pressing “Ctrl+V” in MS Excel® or any text editor. 

Data can be exported to any format directly from the AGD file viewer by clicking on “Export Data To...” above the 
data graph.  This is equivalent to selecting “Export” from the File menu. 

 
FIGURE 14 – AGD FILE VIEWER 

LOAD TEMPLATE 
The ‘Load Template’ option allows users to browse and locate an ActiLife template file (*.agt) which forces ActiLife 
to pre-defined initialization and/or download parameters to ensure consistency among all sites.  For details on 
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using the template editor, see Building and Using a Template.  Once a template is loaded, details about the 
template including the template name and ‘last modified’ date will appear in the upper right-hand corner of the 
ActiLife tool as shown in Figure 15. 

 
FIGURE 15 – TEMPLATE-IN-USE INFORMATION 
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REMOVE TEMPLATE 
The ‘Remove Template’ option simply disables any active template that ActiLife is using.  The current template 
information as shown in Figure 15 will disappear after using this option.  For more information about the template 
feature, see Building and Using a Template. 

TEMPLATE EDITOR 
The template editor loads the template editor form which can be used to create new or modify existing templates 
for use with all versions of ActiLife.  For more information, see Building and Using a Template. 

SHOW DOWNLOAD FOLDER 
The Show Download Folder simply opens ActiLife’s default download folder.  This option is useful for locating files 
downloaded from devices in the Devices tab. 

SHOW CSV FOLDER 
The Show CSV Folder opens the default CSV conversion/download folder 

 

Note. The template editor is not available in ActiLife LITE. 

EDIT MENU 

 
FIGURE 16 – EDIT MENU 

The “Copy” and “Select All” options in the Edit menu allow users to select and copy elements in the selected grid 
so that they may be pasted into a text or spreadsheet editor.  These apply to any tab within ActiLife.  

GENERAL OPTIONS 

UPDATE OPTIONS 
Checking “Check for Program Updates” enables ActiLife’s auto-update feature and allows ActiLife to check for 
program updates via the Internet when the program starts up.  If an Internet connection is unavailable, ActiLife 
automatically skips this step.   

Important: It is strongly recommended that this option remain checked.  
Doing so ensures that the user has the latest version of ActiLife.  Older 
versions of ActiLife may have bugs or issues which could affect data collection 
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and/or device interaction.  ActiGraph makes every effort to ensure that data 
collection and download are unaffected during program updates 

Each time a device is initialized, ActiLife checks the firmware version on the device.  If it is not the latest version 
available from ActiGraph, it is automatically loaded onto the device prior to re-initialization.  Because all data on a 
device is deleted prior to flashing firmware, firmware updates are only performed just prior to re-initialization 
during which time the device is fully erased.  The “Update Firmware on Initialization” option allows the user to 
disable this feature.  However, in order to guarantee that all devices remain up to date, this feature is permanently 
checked and enabled and cannot be unchecked.  In order to disable this feature, contact ActiGraph support at 
support@theactigraph.com.   

It should be noted that ActiLife automatically downloads the latest version of firmware (for all ActiGraph devices) 
each time the program loads.  In this way, ActiLife makes every effort to keep users updated with the latest 
firmware for their devices.  The latest firmware files can be found in the C:\Users\<user 
name>\Documents\ActiGraph\ActiLife\FirmwareFiles directory.   

ActiLife ships with the latest versions of firmware available in an effort to ensure that our offline customers remain 
updated. 

UNITS OF MEASUREMENT 
Use these options to select the desired units of measurement throughout the ActiLife software (in all grids and in 
all exports).  If “English” is selected, users have the option to display subject height information in inches or 
Ft/Inches. 

TIMESPAN DISPLAY 
The Timespan Display settings set the default view for the ‘Current Data Recorded’ display in the Devices grid.  
Selecting the default (Days Hours Minutes Seconds) breaks the display of time parameters in ActiLife’s grids into 
four parts (days, hours, minutes, and seconds).  Checking “Show text for ‘D’ ‘H’ ‘M’ and/or ‘S’” annotates the time 
with letters corresponding to hours, minutes or seconds (e.g., 820m versus 820 – useful for copy/pasting into a 
text or spreadsheet editor that may not use the h/m/s notation). 

DIRECTORIES 
Use this option to set the default directories for data downloads, firmware storage, and CSV file creation 

DOWNLOADING 

DOWNLOAD NAMING CONVENTION 
These options set the default naming convention for downloaded files.  During the download process, users have 
the option to change this option. 

CREATE FILE OPTIONS 

CREATE DAT AND CSV WITH AGD DOWNLOAD 
Use these options to create a *.dat or *.csv file at the time of download.  Important: These options only work 
whenever an AGD file is created.  Hence, when downloading a GT3X+ device, *.dat and *.csv files will not be 
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created when these options are checked unless the “Create AGD File” is checked during the download process (see 
Downloading GT3X+ Devices for details on creating an AGD file on download). 

ADD COLUMN HEADERS TO CSV 
Checking this option will add column header labels to the columns in CSV (like “Axis 1,” “Axis 2,”, “Axis 3,” “Steps,” 
etc.) files when those files are created via export. 

COMPRESS GT3X+ FILES 
This option will apply maximum file compression to *.gt3x files when they are downloaded from GT3X+ devices.  
This compression can greatly reduce the file size of the *.gt3x zip files, but can double the post-processing time 
(i.e., the time it takes to create an *.agd file from a *.gt3x file).  For details on post-processing, see Uncompressing 
*.gt3x Files. 

CREATE SUB-FOLDERS WHEN EXPORTING "RAW TO EPOCH" 
Check this option to create sub-folders for *.agd, *.dat, and/or *.csv files created when exporting from “Raw to 
Epoch” files from the Import/Export menu. 

CREATE AGD DURING DOWNLOAD OF GT3X+ OR ACTISLEEP+ 
When checked, this option tells ActiLife to automatically create an *.agd file immediately after downloading *.gt3x 
files from ActiSleep+, GT3X+ or wGT3X+ devices.  For more information on these file types, see Appendix A – File 
Types in ActiLife. 

SCAN OF GT3X+ DOWNLOADS 
When downloading GT3X+, ActiSleep+, or wGT3X+ data, this option allows users to be notified of large gaps (null 
data or 0s) in the data which may indicate either a problem with the device itself or non-compliance with the 
device end-user.  Setting this option to a certain percentage will prompt the user if there are more than that 
percentage of the data contains 0s.  For example, setting to 10% will cause notifications to appear when 10% or 
more of the data on the device contains null data (0s).  Set this option to 100% to disable notifications. 

WEAR TIME VALIDATION 
Wear Time Validation options are used to set the default values for the dataset filters in the Wear Time Validation 
tool.  The user also has the option to switch between the Floating Window or Daily Wear Time Validation 
algorithms.   

Note: The daily algorithm has been deprecated and should be avoided. 

DATA SCORING 
The Data Scoring options are used to set default values for the algorithms available in the Data Scoring tool in 
ActiLife.  Whenever the Data Scoring tab is opened, the default values set in this options dialog will be used; 
however, they can be changed directly from within the Data Scoring tool. 

Note that clicking the “?” icons to the right of each algorithm option will open the ActiGraph support website and 
reveal the origin of each of the algorithms.  Reference abstracts are available from the support site. 
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BOUTS – USE VECTOR MAGNITUDE 
When this option is checked, the vector magnitude of 3-axis devices will be used to calculate bout levels. 

SLEEP SCORING 
The Sleep Scoring option allows the user to set the default Sleep Scoring Formula for the Sleep Scoring Tool.  See 
Sleep Scoring Algorithms for more information. 

Checking the “Create Clinical Report on Download” will cause ActiLife to automatically create a clinical PDF report 
immediately after download.  See Clinical Report for details. 

COLORS 
The Colors option allows the user to set the default colors for all graphing items in ActiLife.  The “Multiple Colors” 
checkbox in the Progress Bar section will cause ActiLife to use multi-colored progress bars in the Devices tab when 
interacting with multiple devices. 

UPDATE FIRMWARE FROM FILE 
Within the “Advanced” menu, the Update Firmware from File option allows users to manually upgrade (or 
downgrade) device firmware.  From the Devices tab, select the devices that need to be upgraded then select the 
Update Firmware from File option.  A dialog box will allow the user to select a firmware file for each of the 
connected devices types.  After the file has been selected, click “OK to update the firmware. 
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Important: Manually upgrading or downgrading firmware is not 
recommended.  Doing so could render your ActiGraph device unusable and 
could void the product’s warranty.  Contact ActiGraph support prior to 
manually changing the firmware.  Under normal circumstances, ActiLife will 
automatically update the devices firmware. 

TOOLS MENU 

  

FIGURE 17 - TOOLS MENU 

The Tools menu contains options for printing a sleep diary, creating a clinical report, correlating GPS data with data 
from ActiGraph devices and merging multiple AGD files together. 

PRINT SLEEP DIARY 
Many times, it is useful to provide patients with a sleep log for making subjective logs of time-in-bed (TIB) and 
time-out-of-bed (TOB) times so that sleep analyses can be properly performed.  The “Print Sleep Diary” option in 
the Tools menu allows users to export a printable sleep diary for patients to use while they are wearing a device.  
Click the option and select a location to store the log diary (PDF format).  A screenshot of the log diary is shown in 
Figure 18. 
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FIGURE 18 - SLEEP LOG (DIARY) 

CLINICAL REPORT 
ActiLife can create a clinical report which contains the following information: 

 Subject and Device Information (Name, Weight, Device Serial Number, Start/End Time) 
 Wear Time Information 
 Energy Expenditure 
 Cut Points 
 Sleep Graphs 
 Sleep Period Breakdown and Summary 

The clinical report can be used to quickly generate a report on an individual in a clinical environment without 
running through all of the tools in ActiLife. 
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GENERATING A CLINICAL REPORT 
When downloading data from an ActiSleep or ActiSleep+ device, users can generate a Clinical Report by simply 
checking the box “Create Clinical Report on Download…” as shown in Figure 19.   

 
FIGURE 19 - CLINICAL REPORT ON DOWNLOAD 

The report can also be generated after a data download through the tools menu.  Select the *.agd file that was 
generated from an ActiSleep or ActiSleep+ device and click “Open”.   

CLINICAL REPORT DEFAULT VALUES 
The Clinical Report generator uses the default values stored in the Wear Time Validation tool to calculate wear and 
non-wear time.  Similarly, the tool also uses the default algorithms selected in Data Scoring (on last program close) 
to calculate Energy Expenditure.  To change the algorithms, open ActiLife, navigate to the Data Scoring tab, switch 
to a new energy expenditure algorithm and close the program.  If sleep times have already been entered via the 
Sleep Analysis tool, the Clinical Report tool will use those times to calculate the sleep score and graph information 
in the report.  If not, the Auto Score feature will be utilized. 

Note: The Clinical Report tool is only available for data collected using the 
ActiSleep or ActiSleep+ devices.  This feature can be enabled for non-ActiSleep 
devices for a small fee.  Contact ActiGraph support at 
support@theactigraph.com for more information. 

CORRELATE GPS DATA 
More info coming soon. 
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MERGE AGD 
This option allows the user to Merge any 2 compatible AGD files having the same epoch length. 

 

Select any 2 AGD Datasets having the same epoch length. After the second file is chosen, you will get an option as 
displayed below. 

 

Choose the device serial number and click the MERGE button. This should save the combined file in the same PATH 
as the source file. 

If any 2 incompatible epoch length files are chosen, the user will see error as below. 
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SPLIT AGD 
This option allows the user to split any large AGD file into multiple AGD files. 

 

Choose any AGD file and you will see option as provided below 
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The user can split files either by 

 Clicking on any timeline in the window where the SPLIT icon is present, and it will update the SPLIT DATE 
accordingly 

 OR vice versa. 

Once successfully split, the split files will be saved in the same folder as the source file. The files with be suffixed 
with _A and _B after the source file name. 

HELP MENU 

  

FIGURE 20 - HELP MENU 

ONLINE SUPPORT 
Click this option to access our online support system 
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VIEW WELCOME TOUR 
This option launches the ActiLife introduction dialog that outlines what’s new in the current release. 

ACTIVATION DETAILS 
Click this option to view the ActiLife product key, the edition type, and the maintenance expiration date. 

DEACTIVATE 
ActiLife licenses are node locked to the machine on which the software is installed.  Users are allotted a specific 
number of activations on various machines.  In order to prevent losing an activation, ActiLife should be deactivated 
before it is uninstalled and removed from its host computer.  To deactivate ActiLife and reclaim the activation, 
select the Deactivate option and click “Deactivate ActiLife.” 

 
FIGURE 21 - DEACTIVATE DIALOG 

CHECK FOR UPDATES 
Clicking this option will force ActiLife to check for any maintenance updates.  This action is done automatically 
each time ActiLife is loaded, but may be manually done via this method. 

ABOUT ACTILIFE 
The About ActiLife option displays information about the ActiLife program including the software version number 
(also available in the main dialog frame), copyright information, and a link to ActiGraph’s corporate website. 
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DEVICE INITIALIZATION AND DOWNLOAD 
Once ActiLife is properly installed and licensed, users will be presented with the “Devices” screen similar to the one 
shown in Figure 22.  ActiLife is capable of initializing or downloading multiple devices simultaneously.  Devices can 
be connected either before or after ActiLife is launched.  

 

 
FIGURE 22 – OPENING SCREEN 
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Important: Attempting to communicate with multiple GT1M and GT3X 
devices has been known to be problematic.  Users may see an error similar to 
the one shown…  To remedy the problem, ensure that the USB hub in use is a 
powered hub (ActiGraph recommends the 7-port ConnectLand sold on the 
theactigraph.com store).  Sometimes a retry will fix the issue, but not always.  
Read more about the problem on our FAQ page here. 

As shown in Figure 23, device status information will appear in the “Devices” tab as devices are connected to the 
computer. Device status information is provided in the Devices grid. 

 
FIGURE 23 - ACTILIFE DEVICES TOOL 

DEVICE 
The “Device” column describes the type of ActiGraph device(s) connected to the PC.  Mixing devices is allowed. 

SERIAL # 
The “Serial #” column displays the serial number of the device connected. 

STATUS 
The “Status” column displays the current status of the attached device.  The status could be “Ready,” “Idle,” 
“Initializing,” “Finished Initializing,” “Updating,” “Downloading,” “Finished Downloading,” or “Finished Creating 
Clinical Report.” 

PROGRESS 
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The “Progress” column contains the progress bar indicating the progress toward completion of the status indicated 
in the “Status” column. 

FIRMWARE 
The “Firmware” column displays the current firmware version on the device.  Firmware is automatically updated 
during initialization.  See Update Options for more details. 

BATTERY VOLTAGE 
This column displays the device’s battery voltage and charge percentage.  For more information, see device 
owners manual. 

TOTAL MEMORY 
The Total Memory column displays the total memory available on the device.  MB = Megabyte (or 1048576 bytes). 

CURRENT DATA RECORDED 
This column displays the current number of days, hours, minutes, and seconds of recorded data on the device.  To 
adjust how this appears, see Timespan Display. 

EPOCH/SAMPLE RATE 
For non-GT3X+ devices, this column represents the accumulation epoch length.  For GT3X+ devices and non-GT3X+ 
devices in raw data collection mode, this column represents the sample/store rate. 

SUBJECT NAME 
This column displays the subject name currently stored on the device. 

START DATE & TIME 
This column displays the start date and time programmed on the device. 

STOP DATE & TIME 
This column displays the stop date and time programmed on the device.  This option can be set during initialization 
and is used to align the file lengths for multiple devices during large longitudinal studies. 

FILTER 
The “Filter” column displays the on-board accelerometer filter setting for initialized devices (Normal or Low-
Frequency-Extension).  See Setting Device Parameters for details.  This column is not applicable for GT3X+ devices 
as no on-board filtering is performed. 

AXIS ENABLED 
The “Axis Enabled” column indicates which axes are being sampled and stored.  1 –vertical axis only (Axis 1); 2 – 
vertical and horizontal (Axes 1 and 2); 3 – vertical, horizontal, and lateral (Axes 1, 2, and 3). 

MODES 
The “Modes” column displays icons representing the data channels that the device is set to log (if initialized).  The 
icons and their meanings are interpreted in Table 1. 
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Mode/Channel 
Icon 

Interpretation 

 

Flash LED Mode Enabled  
(LED flashes periodically to indicate device 

is active).  See Recharging and LED 
Decoding for more details. 

 

Step counting enabled. Indicates that the 
device is recording step counts per epoch.  

See Steps for more details. 

 

Inclinometer enabled. Indicates that the 
device is recording orientation data which 

will later be interpreted as sitting, standing, 
lying, or off.  See Inclinometer for more 

details. 

 

Lux (ambient light) sensor enabled.  
Indicates that the device is collecting light 

data.  See Lux (Ambient Light) for more 
details. 

 Reset 

 Halt 

 
Wireless enabled 

 
Bluetooth enabled – central mode 

 Bluetooth enabled – peripheral mode 

 Bluetooth enabled – central plus mode 

 Display enabled 

 Display 24 hour format 

 
LED when collecting 

 
LED when in delay 

 
Sleep mode 
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Daily summary aggregation 

 
Epoch summary (60 second) 

 
Raw Disabled 

 
Proximity Tagging 

 
IMU enabled 

 
Delay 

 
Steps 

 
Heart rate 

 
Lux enabled 

 
Inclinometer 

TABLE 1 – MODE/CHANNEL ICON DEFINITIONS 

MORE INFO 
The button in the “More Info” column is for debug purposes by ActiGraph support and should not be required to 
operate the device(s). 

The data in the Devices grid can be copied and pasted into any text editor by clicking on a cell, pressing and holding 
the Shift key and clicking on another cell to select a group of cells then pressing “Ctrl+C” to copy the data to the PC 
clipboard.  This can be useful for studies in which device data must be logged. 

 

IMPORTANT: Device drivers must load the first time a device is connected to a 
USB port.  Devices may take a few seconds to load during device driver 
enumeration.  GT3X+ and ActiSleep+ devices may cause Windows to display 
the AutoRun prompt (asking the user to choose a default action upon 
opening.  The ActiGraph software development team is working on 
eliminating this action. 
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The user views the details related to the sensor’s enabled status in the watch. Ex. in image above, the following 
information shows the sensors enabled in the LEAP device. 

INITIALIZING DEVICES 
Select a check box corresponding to the devices to be initialized (or select all devices”) and click “Initialize.”  A 
dialog similar to Figure 24 will appear. 
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FIGURE 24 A - INITIALIZATION DIALOG FOR GT3X+ VS GT3X 
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FIGURE 25 B - INITIALIZATION DIALOG FOR LEAP V1.0 AND V2.0 

 

SETTING DEVICE PARAMETERS 
The ‘Initialize Device(s)’ screen contains a separate tab for each type of ActiGraph device connected to the PC and 
appears after clicking the “Initialize” button at the top of the “Devices” screen.  Tabs across the top represent the 
types of devices to be initialized.  If multiple devices of each type are selected, the tab group applies to all devices 
of that type. 

Select the tab for the type of device you wish to configure and set the specific data collection parameters.  Filter 
information can also be set at the time of initialization.  For more details about the low frequency extension, see 
Low Frequency Extension.  All ActiGraph devices of the same type that are initialized simultaneously will be initialized 
with the same data collection parameters.   

Start Date and Time and Stop Date and Time apply to all devices and cannot be unique for each device group.  Stop 
time is optional. 

The “Max Recording Time” for each device is shown in the Initialization screen.  This number will change depending 
upon the number of axes selected, the epoch length, and the number of active channels (see Available Channels 
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(Modes) for details of the meaning of each setting).  Most devices’ “Max Recording Time” will far exceed the battery 
life of the device. 

The icon in the top right corner of the initialization screen indicates which axes are selected.  As the “# of Axis” 
dropdown box is increased, so too are the number of logged axes.   

GT3X+ devices collect data from all channels regardless of initialization settings.  The only settings available for the 
GT3X+ are the raw Sample Rate and the “Flash LED” options as shown in Figure 24. 

After data collection parameters have been set up for each model, select the ‘Enter Subject Info…’ button. 

SUBJECT INFO 
The Subject Name screen allows users to enter a unique subject name for the attached devices.  This data will be 
stored on the device and will be available at download and can help with file naming when data is downloaded 
from the device.  To add or change a name, highlight the subject name cell.  Note that GT3X+ devices (devices with 
serial numbers beginning with ‘NEO’) will store more information.   

 
FIGURE 26 – SUBJECT NAME ENTRY FORM 

If desired, the “Use Serial Number” button will populate the Subject Name column with the serial number of the 
device.  Similarly, the “Use Device Info” button will automatically populate the Subject Name column with the 
Subject Name currently stored on the device.  The “Clear” button will erase the fields for easier editing. 

Important: If any devices have a voltage less than 4.1 volts, we recommend 
leaving them connected, allowing them to charge fully if time allows. 
Updated voltage can be viewed by selecting the ‘Refresh All’ tab (or F5) from 
the devices screen. 

GT3X+ BIOMETRIC INFO STORAGE 
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GT3X+ Devices (NEOxxxxxxxxxx) can optionally store extra biometric information during initialization which can be 
used for post-processing after downloading data from the device (see Figure 26 for details).  GT3X+ devices can 
store the following information in addition to the “Subject Name” which is standard on all devices: 

 Gender – Male or Female 
 Height – Subject height in inches or ft. /inches depending upon the settings. 
 Weight – Subject weight in lbs. or kg, depending upon the settings. 
 Date of Birth – Subject’s date of birth (mm/dd/yyyy) 
 Race – Subject race: Asian/Pacific Islander, Black/African American, White/Caucasian, Latino/Hispanic, 

Other 
 Limb – The limb on which the device is worn: Wrist, Waist, Ankle, Upper Arm 
 Side – The side of the body that the patient is wearing the device.  Left or Right 
 Dominance – Dominant or Non-Dominant.  This allows the researcher to store whether or not the wear 

location is on the subject’s dominant or non-dominant side. 

This data is stored in the info.txt file as part of the *.gt3x zip file when data is downloaded from the GT3X+ device. 

When all names have been entered, select the ‘Initialize All’ button and the progress is displayed in the ‘Status’ 
column (refer to Figure 23).  When the initialization is complete, the devices are ready to be removed.  

DOWNLOADING DEVICES 

FILE FORMAT 
Downloading data from the actigraph device is a simple process.  It is important to understand how the data on 
the device is formatted and what is contained in the file.  The device files can be in GT3X or AGSD file format. 
However, when downloading data the accelerometer data can be stored in the *.agd file..  .  The *.agd file schema 
can be found in Appendix A of this users guide. 

DOWNLOADING LEAP, GT1M, GT3X, ASM, AND/OR ACTITRAINER DEVICES 
To download data from LEAP, GT1M, GT3X, ASM, or ActiTrainer devices, connect your device(s) to the computer – 
ActiLife will detect those devices and they will appear in the Devices grid.  Select (check the box) the devices that 
you wish to download and click “Download” at the top of the screen.  The Download Options screen will appear 
allowing you to select the type of file naming convention you would like.  The names can always be changed later 
or you can select ‘Prompt for Each Download’ to enter unique names for each downloaded device.  These options 
help to prevent name duplication during batch downloading. 



  
 

Page | 33 
 70 North Baylen Street, 

Suite 400 
 

Pensacola, FL  32502 tel 850.332.7900 
 

 +1.877.497.6996  
(Toll Free) 

 
 

 
FIGURE 27 – DOWNLOAD OPTIONS WINDOW (UPDATE!!!!!!!) 

To select a different download location, select “Select Download Location…” and browse to the desired download 
directory.  To make this directory the default download directory, check the box below the download location in 
the Download Options prompt.  This can also be changed by selecting the directory from the “Edit->Options-
>Directories” setting in the program’s main menu.   

SAVING BIOMETRIC DATA DURING DOWNLOAD 
During the download process, ActiLife gives the user the option to store metadata information associated with 
each device and corresponding device wearer.  After clicking ‘Download’ from the devices grid, check the box 
entitled “Add biometric and user information” to expand the details grid below the download form.  This form is 
shown in Figure 28.  All of the fields shown here are optional. 
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FIGURE 28 - DOWNLOAD OPTIONS WITH BIOMETRIC INFORMATION 

SUBJECT NAME 
Unless it is changed, the” Subject Name” will default to the subject name used to initialize the device.  Even if the 
biometric and user information grid is not expanded for population, the “Subject Name” will be stored with the 
*.gt3x or *.agd file upon download.  From this grid, the “Subject Name” can be changed prior to downloading. 

GENDER 
Click the “Gender” column to reveal a dropdown menu.  Select Male or Female.   

HEIGHT 
Use the “Height” column to enter the subject’s height in inches, centimeters, or feet/inches.  Select a different 
format by changing the Units of Measurement in the Options menu. 

WEIGHT 
Use the “Weight” column to enter the subject’s weight in lbs or kg.  Select a different format by changing the Units 
of Measurement in the Options menu.  
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DATE OF BIRTH 
Use the “Date of Birth” column to edit the subject’s date of birth.  A calendar picker is provided, but it may be 
more convenient to simply type in the subject’s birthday.  The date format is mm/dd/yyyy. 

RACE 
Use the “Race” column to select the subject’s race.  Select “White/Caucasian,” “Black/African American,” 
“Latino/Hispanic,” “Pacific Islander,” or “Other”. 

LIMB 
Use the “Limb” column to select where the device was worn.  Options include “Wrist,” “Waist,” “Ankle,” and 
“Thigh.” 

SIDE 
Use the “Side” column to specify the device wear location (left or right side of the body). 

DOMINANCE 
The “Dominance” option allows users to specify whether the wear location side was the subject’s dominant or 
non-dominant side. 

CUSTOM FIELDS 
When custom fields are collected as part of a template (see Building and Using a Template for more details), those 
custom fields will appear in the metadata grid as shown in Figure 29.  Additionally, the “Add Biometric and User 
Information” check box option will be permanently selected and entry of the custom fields will be required. 

 
FIGURE 29 – CUSTOM FIELDS IN THE BIOMETRIC AND USER INFORMATION GRID 

 

Clicking “Download All Devices” from the form will download the data from the selected units and store the data in 
SQLite format stored with a *.agd file extension (See Appendix A – File Types in ActiLife). 

ActiLife no longer stores data in DAT or CSV format. To convert data into one 
of those formats, select ‘File’ tab then the Import/Export option as shown in 
Figure 10. 

ActiLife can automatically create *.csv files on download by setting this in the 
edit menu.  Note that this only works for GT3X+ devices if an *.agd file is 
created during the download process. 
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DOWNLOADING GT3X+ DEVICES 
Downloading data from GT3X+ devices is very similar to download from other devices.  It is important to 
understand the difference in the file handling for this device.  In order to increase the efficiency of the download 
process, data from GT3X+ devices is downloaded in raw, binary format with file extension *.gt3x (see Appendix A 
– File Types in ActiLife which explains the *.gt3x format).  This binary format mirrors the proprietary compressed 
raw data format stored on the device itself and is unreadable by standard text editors.  In order to read the data or 
process the data with ActiLife, the *.gt3x files need to be uncompressed (i.e., exported to *.agd format) using 
ActiLife.  This can occur either during download or later when processing files. 

To download data from a GT3X+, select the device(s) from the grid in the Devices tab and click “Download”.  A 
prompt similar to Figure 28 will appear.  Clicking “Download All Devices” will immediately download all of the data 
from the GT3X+ into the user’s default download directory.  

SCANNING OF GT3X+ DATA DURING DOWNLOAD 
Data downloaded from GT3X+ devices can be scanned for problems at the time of download.  At this time, ActiLife 
can scan for null data (0s) which may indicate issues with the device accelerometer or non-compliance by the end-
user.  To enable this scanning, open the Edit->Options menu and choose the Downloading submenu.  In the “Scan 
of GT3X+ Download” section, select the warning threshold.  Doing so will warn the user during the download 
process if the number of 0s within the file exceed the threshold.  To disable this feature, set the threshold to 100%. 

To view the *.gt3x files, select “Communication->Show Download Folder” from the main menu in ActiLife.  Files 
will appear in this folder as shown in Figure 30. 

 
FIGURE 30 – *.GT3X FILES 

UNCOMPRESSING *.GT3X FILES 
Binary *.gt3x files can be uncompressed to *agd (for use in ActiLife), *csv, or *.dat file format.  Users have the 
option of creating *.agd files during the download process by checking “Create AGD File” from within the 
download prompt (see Figure 31).  Because GT3X+ devices record raw accelerometer data (see Appendix A – File 
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Types in ActiLife for details), the parameters for the uncompressed file must be set at the time of download if the 
“Create AGD File” option is checked.  These parameters include the uncompressed epoch length, the number of 
axes, step counting, lux (light data), inclinometer (standing, sitting, lying, or off detection), and/or low frequency 
extension.  For an explanation of these parameters, see Available Channels (Modes) for details. 

 
FIGURE 31 - CREATING AN AGD FILE ON DOWNLOAD 

Important: Creating an AGD file during the download process will increase the 
download time significantly depending upon the size of the download.   

Binary *.gt3x files can be uncompressed at a later time if desired (e.g., after emailing or sharing the files).  To 
uncompress these files at a later time, select “File->Import/Export->Create AGD/CSV/DAT from Raw GT3X+” from 
the ActiLife main menu.  An export window similar to the one shown in Figure 32 will appear.  Individual *.gt3x 
files can be added by selecting the “Add GT3X+ Files(s)” option.  All of the *.gt3x files in a directory can be added 
by selecting “Add Directory…”  Once files are added, the desired file type(s), epoch length, and parameters can be 
selected within the export tool.  Select “Create File(s)” to export these files to the default download directory. 
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FIGURE 32 – GT3X+ EXPORT TOOL 

The GT3X+ export tool can also be accessed by clicking “finished downloading” hyperlink from the devices grid 
after downloading as shown in Figure 33.   

 
FIGURE 33 – FINISHED DOWNLOADING HYPERLINK IN DEVICES GRID 

Clicking this link for GT3X or legacy ActiSleep devices as shown in Figure 34 will launch the AGD viewer, since these 
downloads produce an *.agd file by default (see Appendix A – File Types in ActiLife for more information). 

 
FIGURE 34 – “FINISHED DOWNLOADING…” LINK IN STATUS COLUMN. LINKS TO AGD VIEWER FOR GT3X AND ACTISLEEP DEVICES 
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DOWNLOADING LEAP DEVICES 
Downloading data from a LEAP device is very similar to download from other devices.  It is important to 
understand the difference in the file handling for this device.  In order to increase the efficiency of the download 
process, data from LEAP devices is downloaded in raw, binary format with file extension *.agsd (see Appendix A 
– File Types in ActiLife which explains the *.agsd format).  This binary format mirrors the proprietary compressed 
raw data format stored on the device itself and is unreadable by standard text editors.  In order to read the data or 
process the data with ActiLife, the *.agsd files need to be uncompressed (i.e., exported to *.agd format) using 
ActiLife.  This can occur either during download or later when processing files. 

To download data from a LEAP device, select the device(s) from the grid in the Devices tab and click “Download”.  
A prompt similar to Figure 28 will appear.  Clicking “Download All Devices” will immediately download all of the 
data from the LEAP device into the user’s default download directory.  

SCANNING OF LEAP DATA DURING DOWNLOAD 
Data downloaded from LEAP devices can be scanned for problems at the time of download.  At this time, ActiLife 
can scan for null data (0s) which may indicate issues with the device accelerometer or non-compliance by the end-
user.  To enable this scanning, open the Edit->Options menu and choose the Downloading submenu.  In the “Scan 
of LEAP Download” section, select the warning threshold.  Doing so will warn the user during the download 
process if the number of 0s within the file exceed the threshold.  To disable this feature, set the threshold to 100%. 

To view the *.agsd files, select “Communication->Show Download Folder” from the main menu in ActiLife6.  Files 
will appear in this folder as shown in Figure 30. 

 

 
 

FIGURE 35 – *.GT3X FILES 
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UNCOMPRESSING *.AGSD FILES 
Binary *.agsd files can be uncompressed to *agd (for use in ActiLife), *csv, or *.dat file format.  Users have the 
option of creating *.agd files during the download process by checking “Create AGD File” from within the 
download prompt (see Figure 31).  Because LEAP devices record raw accelerometer data (see Appendix A – File 
Types in ActiLife for details), the parameters for the uncompressed file must be set at the time of download if the 
“Create AGD File” option is checked.  These parameters include the uncompressed epoch length, the number of 
axes, step counting, lux (light data), inclinometer (standing, sitting, lying, or off detection), and/or low frequency 
extension.  For an explanation of these parameters, see Available Channels (Modes) for details. 

 

 

                 FIGURE 36 - CREATING AN AGD FILE ON DOWNLOAD 

Important: Creating an AGD file during the download process will increase the 
download time significantly depending upon the size of the download.   

Binary *.agsd files can be uncompressed at a later time if desired (e.g., after emailing or sharing the files).  To 
uncompress these files at a later time, select “File->Import/Export->Create AGD/CSV/DAT from Raw agsd” from 
the ActiLife main menu.  An export window similar to the one shown in Figure 32 will appear.  Individual *.agsd 
files can be added by selecting the “Add LEAP Files(s)” option.  All of the *.agsd files in a directory can be added by 
selecting “Add Directory…”  Once files are added, the desired file type(s), epoch length, and parameters can be 
selected within the export tool.  Select “Create File(s)” to export these files to the default download directory. 
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FIGURE 37 – GT3X+ EXPORT TOOL 

The agsd export tool can also be accessed by clicking “finished downloading” hyperlink from the devices grid after 
downloading as shown in Figure 33.   

 
FIGURE 38 – FINISHED DOWNLOADING HYPERLINK IN DEVICES GRID 

Clicking this link for AGSD or legacy ActiSleep devices as shown in Figure 34 will launch the AGD viewer, since these 
downloads produce an *.agd file by default (see Appendix A – File Types in ActiLife for more information). 

 

 
FIGURE 39 – “FINISHED DOWNLOADING…” LINK IN STATUS COLUMN. LINKS TO AGD VIEWER FOR GT3X AND ACTISLEEP DEVICES 
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BUILDING AND USING A TEMPLATE 
Templates were created to assist customers who deploy ActiGraph devices using remote distribution centers or 
who need to ensure consistency in the initialization and/or download process when multiple people (e.g., lab 
assistants) are distributing devices to patients.  Templates can be created only from within the full version of 
ActiLife (ActiLife Lite does not support template creation – only template usage).   

Once a template is created, the template can be saved as an *.agt file.  This file can then be shared via email, jump 
drive, or any other means to various distribution centers or lab partners.  Opening this file will force ActiLife to use 
the settings defined in the template editor to initialize and download devices, thus ensuring data collection 
consistency. 

TEMPLATE EDITOR 
ActiLife Full users will find an option in the File menu entitled “Template Editor.”  Clicking this option will load a 
form similar to the one shown in Figure 40.  Use this form to setup the desired default initialization and download 
parameters defined below in Template Parameters. 

 

 
FIGURE 40 – INITIALIZATION/DOWNLOAD TEMPLATE EDITOR 

TEMPLATE PARAMETERS 
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INITIALIZATION TEMPLATE OPTIONS 
Use the initialization options on the left side of the template editor to force template users to use specific settings 
during the initialization process. 

Template Name (required) 
The name of the template that will appear at the top of ActiLife once the template is loaded.  An illustration is 
shown in Figure 15.  This is a required field. 

DEVICE SELECTION 
Selecting “Enable Template for *****” within one or more of the device tabs will force ActiLife to use device-level 
settings during the initialization process for that particular device.   

START/STOP SETTINGS 
Check either Start Date/Time or Stop Date/Time to force template users to use a Start or Stop time during the 
initialization process.  Use the Day selection box to choose a forced start time offset (e.g., +0 day, +1 day, +2 days, 
etc.) and use the time selection box to set the start time.  Use “Any” in the Day selection box to give the user the 
flexibility to choose which day the device should start collecting data but the rigidity to force a start time for data 
collection.  If the template start time has already passed, ActiLife will automatically default to the next day with the 
same start time.  For example, suppose the template is set to force users to start collecting data at “+0 day(s) at: 
3:00pm.”  If a user initializes a device at 4:00pm, the start time will default to the next day at 3:00pm. 

The Stop Date/Time option allows the template builder to set how many days the device should collect data before 
stopping.  Note that the Day setting refers to the number of days AFTER the start time.  Again, use “Any” in this 
field to give the user the flexibility of choosing the stop date but the rigidity of using a specific stop time.  Be sure 
to keep the battery life and memory limitation considerations in mind.  For more details about battery life, refer to 
the specific product manual for the ActiGraph device you are using.  

Leaving either or both of the Start/Stop Settings unchecked will allow the user to select whether or not the 
start/stop times are used during the initialization process. 

SUBJECT NAME SETTINGS 
Checking this option will force template users to use a certain convention when setting Subject Names for devices 
during the initialization process.  These options are self-explanatory with the exception of the “Static” option.  This 
option will force all Subject Names to exactly match the phrase typed here. 

DOWNLOAD TEMPLATE OPTIONS 
Use the download options to force template users to use specific settings during the download process. 

CUSTOM FIELDS 
Enable the “Custom Fields” option to force users to enter more information during the download process.  Use the 
“Max Characters” dropdown box to select the maximum number of characters allowed for this field.  This will 
prevent users from typing too many characters in this field.   

The fields entered here will appear in the download grid as shown Figure 41 after clicking “Download” from the 
devices grid.  Note that these fields must be populated before users can proceed with the download.  In most 
cases (without a template in use), the “Add biometric and user information” check box can be de-selected (all of 
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the biometric data is optional – see Saving Biometric Data during Download for details).  However, when custom 
fields are enabled in the template, this is required and users are forced to enter values for the custom field 
parameters.  Note that the custom fields are always on the right-hand side of the grid.  Users may need to scroll to 
the right to enter the fields.   

Custom fields are stored with the *.gt3x files and/or *.agd files at download time.  When exporting *.gt3x files to 
*.agd format for analysis in ActiLife, the custom fields will be included as part of the export and will be contained in 
the *.agd file.  For details about the *.agd schema, see Appendix A – File Types in ActiLife.  In ActiLife version 5.6.0 
or later, custom fields appear in the AGD File Viewer. 

 
FIGURE 41 – CUSTOM FIELDS AS THEY APPEAR AFTER CLICKING “DOWNLOAD” 

 

DOWNLOAD SETTINGS 
Use the “Download Settings” in the download section of the template builder to force template users to utilize a 
specific file download location and/or a specific file naming convention.  By checking the “Force Download 
Location” and selecting a directory, template users will be forced to use the specific location.  Template builders 
can type in network URLs or any local directory address that may be applicable for the end-users’ specific sites.   
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Note: If the selected directory does not exist, ActiLife will attempt to create 
the directory (e.g., “C:\PatientDownloads”).  If the user does not have 
administrative permissions or otherwise cannot create the directory, this 
feature will automatically disable itself, thus allowing the user to select the 
directory of their choice. 

To force a file naming convention for template users, check the “Force Naming Convention” option and select the 
desired naming convention.  During the download process, file names will be of the same format selected here for 
those users using the template.  The “Concatenate Custom Fields” option will concatenate the custom field 
characters entered by the user during download time.  Multiple custom fields will be concatenated with no dashes 
or separation punctuation.  At this time, there are no options for reordering or hyphenating the file name 
parameters when using the custom field naming convention.  These features will be added in later versions of 
ActiLife. 

SAVING AND SHARING TEMPLATES 
Once the template parameters are set as desired, the template can be saved as a file and shared with other users.  
Users can click the “Save” button in the bottom right-hand corner of the template editor or use the “File” menu to 
save the template file.  From the file menu, a template can be opened to make modifications (click “Open” then 
browse to the template file).  In addition, the template can be saved and immediately put into use by clicking 
“Save and Use.”  This option is helpful when testing the newly created template before emailing or sharing the 
template file. 

Once the template is saved, a new file with an *.agt file extension will be created similar to the one shown in 
Figure 42.  This file can be emailed to distribution centers or shared over local networks within organizations.  
Users who load this template will be forced to use the parameters as they were defined in the template editor. 

 
FIGURE 42 – TEMPLATE FILE SAVED TO A USER’S DESKTOP 

LOADING TEMPLATES 
Once the *.agt template file has been shared, ActiLife (Full or Lite) users can simply download the file to their local 
machine (anywhere) and double-click on the file.  Doing so will launch ActiLife and load the template.  When done 
correctly, the template name and “Last Modified” time will appear in the upper right-hand corner of the ActiLife 
software as shown in Figure 15 on page 11.  Once the template has been loaded once, the *.agt file can be 
removed from the end-user’s computer.  It is not necessary that the file remain on the user’s computer. 

An alternative way of loading a template file in ActiLife is to use the “Load Template” option in the File menu.  
Browse to the template file location and click ‘Open’ to load the template. 

When a template is loaded in ActiLife, the template will remain present even after the software has been closed 
and re-opened. This ensures that the template settings remain unchanged when the host computer is shut down 
and restarted.  To remove a template, click “Remove Template” from the file menu. 
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DATASET ANALYSIS OVERVIEW 
To improve the efficiency of our customers’ research and to reduce the time spent in post-data collection analysis, 
the full version of ActiLife includes several Dataset Analysis tools.  These include the Wear Time Validation tool 
which can be used to filter out intervals of time within the dataset or entire datasets that do not meet patient 
wear criteria, Data Scoring which can be used to estimate energy expenditure, bouts, and more in one or more 
datasets, a Sleep Scoring tool, which is used to generate sleep statistics, and a Graphing tool which can be used to 
look at detailed epoch-by-epoch graphs of a dataset. 

WEAR TIME VALIDATION 
The Wear Time Validation (WTV) tool in ActiLife allows users to easily flag invalid data (or data collected when a 
device was not worn) for exclusion from further analysis.  WTV also provides a summary of the wear-time and non-
wear time results from the datasets.  The Data Screening Criteria allow users to define non-wear periods.  Data 
flagged as non-wear is not removed from the *.agd file - it is simply flagged (within the file) as "wear time" or 
"non-wear time".   

The default Wear Time Validation algorithm uses the floating window technique.  This algorithm does not define 
wear or non-wear time from calendar hours, but rather looks at contiguous time and discerns how many total 
hours (and/or minutes) of non-wear time are in the file without regard for breaks in the calendar day/hour.  
Conversely, the deprecated “Daily Algorithm” looks at calendar hours (e.g., 9:00am – 10:00am) and days (March 2 
– March 3) to determine whether or not that hour (or day) is valid or not.  The floating window algorithm allows 
users to the same thing by using the “Flag Entire Day as Invalid…” option in the Optional Screening Parameters 
section. 

The defaults defined for Wear Time screening (60 minutes of consecutive zeros with a 2 minute spike tolerance) 
were loosely derived from the research note Identification of accelerometer non-wear time and sedentary 
behavior, published in the Research Quarterly for Exercise and Sport, submitted to the journal on June 1, 
2010.  Permission to share this article publicly has been requested by ActiGraph to the managing editor of 
Research Quarterly for Exercise and Sport. 



  
 

Page | 47 
 70 North Baylen Street, 

Suite 400 
 

Pensacola, FL  32502 tel 850.332.7900 
 

 +1.877.497.6996  
(Toll Free) 

 
 

 
FIGURE 43 - WEAR TIME VALIDATION 

DEFINE A NON-WEAR PERIOD 
This section provides options for defining the non-wear period.  ActiLife will use this information to scan the data 
for non-wear bouts. 

Begin non-wear bout after ____ minutes/epochs of consecutive zeros - After scanning the data and detecting the 
selected number of consecutive zeros, ActiLife will begin flagging data as "non-wear time".  The leading zeros 
detected during this process will be flagged retroactively (after they have been initially scanned).  Data will be 
flagged as "non-wear time" until the Spike Tolerance is exceeded.   

Use Vector Magnitude - When checked, ActiLife scans the vector magnitude of three-axis data (when available) to 
detect wear or non-wear time.  When unchecked, ActiLife scans only Axis 1 (the vertical axis - see users' manual for 
details) to detect wear/non-wear times.   

Use an activity threshold of _____ counts per minute/epoch - Instead of looking for zeros to qualify non-wear time, 
this option allows the user to set a non-zero activity threshold requirement for wear-time.  Data below this value 
will be qualified as "zero". 

Spike Tolerance ____ minutes/epochs - This option allows the user to set a "spurious count" tolerance.  ActiLife will 
continue scoring a non-wear bout as non-wear until it detects more than the Spike Tolerance number of 
minutes/epochs above zero (or above the activity threshold, if that option is enabled). 
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OPTIONAL SCREENING PARAMETERS 
Ignore wear periods less than _____ minutes/epochs - Because of the WTV algorithms used, some wear periods 
may be very short (shorter than the spike tolerance).  Use this option to set the minimum length of an acceptable 
wear period. 

Flag entire day as invalid if wear time less than _____ minutes/epochs - Use this setting to flag an entire 24 hour 
day as invalid if there are less than the selected amount of valid (wear-time) minutes or epochs in the day.   

Change Wear Time Validation Algorithm - This shortcut opens the Wear Time Validation options settings (also 
accessible from the Edit->Options menu) and allows the user to choose between the Floating Window and Daily 
WTV algorithm. 

Once these settings are adjusted, press the “Run Selected” button to run the Wear Time Validation algorithm on 
the selected files.  Clicking the “Save Settings as Default” button will save the settings; ActiLife will remember them 
and use them each time the Wear Time Validation tool is opened. 

VIEWING DETAILS OF WEAR TIME VALIDATION RESULTS 
Summary-level results of the Wear Time Validation process are available in the main grid immediately after the 
process has completed.  The following parameters are available: 

 Wear Periods – The number of wear bouts detected by the algorithm for the entire data set 
 Non-Wear Periods - The number of non-wear bouts detected by the algorithm for the entire data set. 
 Wear Length – Total time the device was worn. 
 Non-Wear Length – Total time the device was not worn. 
 Avg Length Wear Period – Average length of the wear periods (or bouts). 
 Avg Length Non-Wear Period - Average length of the non-wear periods (or bouts). 
 Wear % - Percentage of wear-time for the entire data set 
 Non-Wear % - Percentage of non-wear-time for the entire data set 
 Avg Wear Time per Total Days (All Days) – Total wear time divided by the total number of days in the 

dataset. 
 Avg Wear Time per Days with Wear Time – Total wear time divided by the total number of days in the 

dataset that have >0 wear time. 
 Avg Non-Wear Time per Total Days - Total non-wear time divided by the total number of days in the 

dataset that have >0 wear time. 
 Avg Non-Wear Time per Days with Wear Time - Total non-wear time divided by the total number of days 

in the dataset that have >0 wear time. 

After the wear-time has been calculated, details of each wear and non-wear bout can be viewed by clicking the 
“Details” button to the right of each dataset file name as shown in Figure 44. 
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FIGURE 44 – DETAILS VIEW SHOWS EPOCH-BY-EPOCH VALIDATION 

Details about which days are considered “valid” can be seen in the details view.  An example is shown in Figure 45.  
The Days section details out the number of Wear Time and Non-Wear-Time (in minutes) per calendar day.  The 
percentages of wear and non-wear for each day are also available here.  The VM column represents the total 
“Total Vector Magnitude Counts” for that day (see Appendix B – Vector Magnitude for more details).  This number 
can be used to gauge relative activity from day-to-day. 

The Wear Time and Non-Wear Time Periods section details the wear and non-wear bouts as detected by the Wear 
Time Validation tool.  The “Use?” column indicates whether or not that particular bout will be considered or 
excluded when calculating output scores in the Data Scoring tool.  Non-wear periods are never used and wear 
periods are always used by default.  This can be changed by checking or un-checking the bout of interest.  Clicking 
“Save and Close” will store those changes in the *.agd file. 

Clicking the “More” button next to a wear or non-wear bout will reveal the epoch level breakdown for that 
particular bout on the right hand side.  All data in this view can be copied/pasted by selecting the columns/rows of 
interest, pressing “Ctrl+C” on the keyboard to copy, then pressing “Ctrl+V” to paste the data into a spreadsheet or 
text editor.  Use the individual “export” links to export a wear or non-wear period into a *.csv file. 

 
FIGURE 45 – DETAIL BREAKDOWN OF WEAR AND NON-WEAR TIME FOR A DATASET 
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EXPORT REPORT 
The “Export Report” option exports the information in the Wear Time Validation grid to a comma separated value 
file for sharing and manipulation.  Detailed data can be exported to CSV format from the “Details” view of each 
dataset. 

SCORE SELECTED 
This option pushes the selected files into the Data Scoring tab.  This is typically the next step after Wear-Time 
Validation.  This button speeds up the process by eliminating the need to manually search for the files from the 
Data Scoring file importer. 
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DATA SCORING 
Data Scoring in ActiLife allows users to analyze the details of their dataset(s) by examining Energy Expenditure, 
METs, Activity Cut Points, Activity Bouts, and Heart Rate Energy Expenditure.  Figure 46 illustrates the Data Scoring 
tool in action. 

 

FIGURE 46 - DATA SCORING 

DATE AND TIME FILTERS 
Date and time filtering allows users to isolate the data scoring to specific dates or times of interest.  The results 
shown in the Data Scoring tool only apply to the date and time filters shown in the Date and Time Filters grid.  If no 
filters are present, the Data Scoring results are not limited to any dates or times, but include the entire scope of 
the datasets.   

Multiple filters can be added simultaneously to specifically target certain days or times.  To add a filter, click the 
“+” button from within the Date and Time Filters grid as shown in Figure 47.  Only checked filters will be applied 
during data scoring.  Multiple filters can be checked which forces the Data Scoring tool to generate results for two 
different time periods.  For example, creating a Weekend Mornings filter for Weekends from 6am-10am and then 
a Weekend Afternoons filter for Weekends from 3pm-6pm would produce data scoring results for both of those 
time periods only. 
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FIGURE 47 - DATE/TIME FILTER ENTRY 

Date and time filters can be removed by clicking the “X” icon to the right of the filter.  Remove all filters by clicking 
the “X” at the top of the grid.  Date and Time Filters persist in ActiLife even if the program is closed and re-opened. 
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DATA SCORING PARAMETERS AND ALGORITHMS 
There are five optional parameters that can be calculated from within the Data Scoring tool: Energy Expenditure, 
METs, Cut Points, Bouts, and Heart Rate Energy Expenditure (HREE).  Each parameter has multiple algorithms from 
which to choose.  Each algorithm has been derived by independent researchers from around the world using 
ActiGraph devices.  To view details about the origin of each algorithm, click the “?” icon to the right of each scoring 
parameter.  Check the checkbox next to each parameter you wish to calculate for your dataset(s).  Unchecked 
parameters will not be calculated, displayed, or exported. 

ENERGY EXPENDITURE 
To calculate energy expenditure, check the box next to the “Energy Expenditure” parameter in the Data Scoring 
tool.  Each dataset in the Data Scoring grid must have an associated body.  Weights can be added by clicking on the 
“Weight” box in the Data Scoring grid and typing in the subject’s weight.  Select “Worn on Wrist” if the device was 
worn on the wrist to apply the appropriate scaling. 

Important: The “Worn On Wrist?” option scales down the activity counts 
based on an internally-developed algorithm.  At this time, there are no 
validated energy expenditure algorithms for wrist-worn actigraphy.  
Validated energy expenditure can only be estimated from waist-worn devices. 

METS 
METs, or metabolic equivalent of task, can also be calculated from within the Data Scoring tool.  Multiple 
algorithms are available.  When calculating Children’s METS (Using the “Children Freedson” equation), an age must 
be entered for each file.  If the device was worn on the wrist, the subject’s gender is required. 

CUT POINTS 
Cut point data scoring option allows users to break out the proportion of time (total epochs) within each dataset 
the subject spent in different categories of activity intensity.  Multiple validated cut point sets are available by 
default from within ActiLife.  Users can create their own cut point set by clicking the “edit…” link to the right of the 
Cut Point dropdown and clicking the “+” icon at the bottom of the list as shown in Figure 48.  Enter a Set Name for 
the new cut point set and type in the maximum values for each level (click the “+” icon to create new Cut Points).  
Once complete, click “Save”.   

When the “Cut Points based on Vector Magnitude” box is checked, ActiLife will look at the Vector Magnitude count 
levels for each epoch.  When left unchecked, the cut points apply only to the Axis 1 values for each epoch. 

Details about the default Cut Point algorithms in ActiLife can be found by clicking the “?” icon next to the Cut 
Points option. 
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FIGURE 48 - CUSTOM AND DEFAULT CUT POINTS 

BOUTS 
Bouts of activity can be detected within each data set in the Data Scoring tab.  Use the “Bouts” option to define a 
bout length, the minimum per-epoch count level, the maximum per-epoch count level and the drop time. 

MIN LENGTH 
This option tells ActiLife the minimum bout length to look for. 

MIN COUNTS 
This option tells ActiLife the minimum count value for each consecutive epoch in the bout. 

MAX COUNTS 
This option tells ActiLife the maximum count value for each consecutive epoch in the bout. 

DROP TIME 
The drop time setting acts as a tolerance for bout detection and is best explained through an example.  Suppose 
the bout detection settings (above) are set to Min Length = 10, Min Counts = 1953, and Max Counts = 50000.  With 
the spike tolerance set to 0, the Bout tool will only identify a bout of activity as 10 consecutive epochs of data with 
a minimum activity count of 1953 and a maximum activity count of 50000.  Table 2 illustrates a valid bout while 
Table 3 illustrates an invalid bout when Drop Time = 0.  Because the value 1500 that occurs at 09:03 in Table 3 is 
below the Minimum Count Level and because there is no allowable tolerance, these epochs fail to register as a 
legitimate bout.  The epoch string in Table 3 would, however, qualify as a valid bout if Drop Time were set to 1 or 
higher since the highlighted cell would actually count as a valid bout epoch. 
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09:01:00 09:02:00 09:03:00 09:04:00 09:05:00 09:06:00 09:07:00 09:08:00 09:09:00 09:10:00 
2000 2100 2500 4000 6124 4510 2164 4518 2540 6000 

TABLE 2 - EXAMPLE OF A VALID BOUT WITH DROP TIME = 0 

09:01:00 09:02:00 09:03:00 09:04:00 09:05:00 09:06:00 09:07:00 09:08:00 09:09:00 09:10:00 
2000 2100 1500 4000 6124 4510 2164 4518 2540 6000 

TABLE 3 - EXAMPLE OF AN INVALID BOUT WITH DROP TIME = 0 

With a Drop Time = 2, the epoch string in Table 4 would be considered a valid bout since there are exactly 2 epochs 
that are outside of the min/max epoch levels (they count as valid epochs).  If the epoch value at 06:10 were 
outside of the min/max range, that epoch would mark the end of the bout (it would be 10 epochs long).  The 
epoch string in Table 5 would not qualify as a valid bout under these conditions. 

06:00:00 06:01:00 06:02:00 06:03:00 06:04:00 06:05:00 06:06:00 06:07:00 06:08:00 06:09:00 
2000 2100 2500 4000 1274 4510 2164 862 2540 6000 

TABLE 4 - EXAMPLE OF A VALID BOUT WITH DROP TIME = 2 

09:01:00 09:02:00 09:03:00 09:04:00 09:05:00 09:06:00 09:07:00 09:08:00 09:09:00 09:10:00 
2000 2100 1500 4000 1824 4510 2164 1619 2540 6000 

TABLE 5 - EXAMPLE OF AN INVALID BOUT WITH DROP TIME = 2 

Once a bout is detected, the bout does not end until the drop time tolerance is exceeded.  Suppose the epoch 
string in Table 4 continued as follows: 06:10 – 4305; 06:11 – 3390; 06:12 – 5530; 06:13 – 9930; 06:14 – 100.  The 
epoch at 06:14 would mark the end of the bout which would be 14 minutes long. 

BOUT EXAMPLE 
- Minimum Bout Length: 10 minutes 
- Minimum Count Level to be considered a Bout: 1953 
- Maximum Count Level to be considered a Bout: 5724 
- Tolerance/Drop Time (in minutes): 2 
- Dataset collected in one-minute epoch lengths 
- A string of epoch values from the dataset 
- 1805, 2048, 3159, 4651, 4216, 4673, 5531, 1846, 2615, 2648, 3894, 4869, 5201, 5756, 6165 
- This string contains one bout: 
- 2048, 3159, 4651, 4216, 4673, 5531, 1846, 2615, 2648, 3894, 4869, 5201 
- The value 1846 is considered the first “drop” time 
- The value 5756 is considered the second drop time  
- The value 6165 is considered the third and final drop time.  ActiLife regresses the dataset once 6165 is 

detected to find the last “good” value.  This defines the end of the dataset.  

The “Use Vector Magnitude” option within the bout parameter settings forces ActiLife to use the Vector 
Magnitude combination of all three axes for each epoch when making bout level determinations.  With this option 
unchecked, ActiLife only uses Axis 1. 
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HEART RATE EE 
The Heart Rate EE option calculates the following variables from any datasets that are loaded in the Data Scoring 
tab. 

ADL Heart Rate: Average Daily Living Heart Rate.  This is the average base (resting) heart rate of all ADL qualified 
epochs in the dataset.  In order to qualify as ADL heart rate, an epoch must contain heart rate data below 79 beats 
per minute and one-minute activity data above 100 counts per epoch. 

Avg Active Heart Rate: The average active heart rate in a given dataset.  In order to qualify as active heart rate, 
epoch activity must exceed 1951 counts per minute epoch and heart rate must exceed 80 beats per minute. 

HR Delta: The difference between the Average Active Heart Rate and the Average Daily Living Heart Rate for a 
given dataset 

Avg Active Caloric Expenditure: The average minute-by-minute caloric expenditure (kcal) for all epochs that match 
the “Active Heart Rate” qualifier used to calculate Average Active Heart Rate.  Calories are calculated using the 
Freedson Equation (1997).  

Calibration Ratio: Average Active Caloric Expenditure / HR Delta.  This value is used to determine calories-per-
BPM, or calories that should be associated with the subject’s BPM rate (Active Heart Rate) when activity counts are 
not reliable. 

The HREE algorithm should not be used as a standard for measuring activity energy expenditure and is only an 
estimate of overall energy expenditure when ambulatory movement is not reliable.  For example, HREE may be 
used when a user is riding a bicycle or lifting weights. 

USE VALIDATED DATA IF AVAILABLE 
The “Use Validated Data if Available” checkbox option (shown in Figure 49) tells ActiLife whether to use only the 
wear time as calculated by the Wear Time Validation tool (checked) or whether to use all epochs within the file 
(unchecked) to perform the Data Scoring. 

 
FIGURE 49 - USE VALIDATED DATA IF AVAILABLE 

DATA SCORING COLUMNS 
There are 75 columns of possible optional calculations that can be made within the Data Scoring tool.  Select the 
“Edit Columns” option to view the selected columns and to enable/disable columns.  Enabling more columns will 
extend the time required for ActiLife to perform the calculations and the batch data export (if used). 
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FIGURE 50 - DATA SCORING COLUMNS 

The following parameters can be extracted from user datasets in the Data Scoring tab. 

1. Subject - Name of the subject 
2. Filename - Filename of the subject 
3. Epoch - Epoch length in seconds 
4. Weight - The weight of the subject in lbs. 
5. Age - The age of the subject in years 
6. Gender - The gender of the subject 
7. Date - Date in local format 
8. Hour - Hour in local format 
9. Day of Week - Day of the week name in local format 
10. Day of Week Num - Day of the week number: 1=Monday, 2=Tuesday, etc. 
11. kcals - kcals during this hour 
12. METs - MET rate for a period of time 
13. Bouts - Number of Bouts starting in a period of time 
14. Total Time in Bouts - Time of bouts during a period of time 
15. Avg Time per Bout - Average length of time (in minutes) of bouts during a period of time 
16. Total Counts in Bouts - Total counts in bouts during a period of time 
17. Bout Start - The date and time of the start of a bout 
18. Bout End - The date and time of the end of a bout 
19. Time in Bout - The time of a bout in minutes 
20. ADL Heart Rate - Average Non-Sedentary HR between 41 and 79 
21. Average Active Heart Rate - Average HR during active activity (above light) 
22. Heart Rate Delta - The difference between Average Active Heart Rate and ADL Heart Rate 
23. Average Active Caloric Expenditure - Average amount of calories burned above light activity 
24. Calibration Ratio - Ratio of Average Active Caloric Expenditure divided by Heart Rate Delta 
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25. Light - Length of time in Light in minutes 
26. Moderate - Length of time in Moderate in minutes 
27. Vigorous - Length of time in Vigorous in minutes 
28. Very Vigorous - Length of time in Very Vigorous in minutes 
29. Axis 1 Counts Scored - Sum of counts for Axis 1 (Y-Axis) during scored time 
30. Axis 2 Counts Scored - Sum of counts for Axis 2 (X-Axis) during scored time 
31. Axis 3 Counts Scored - Sum of counts for Axis 3 (Z-Axis) during scored time 
32. Axis 1 Counts Non-Scored - Sum of counts for Axis 1 (Y-Axis) during non-scored time 
33. Axis 2 Counts Non-Scored - Sum of counts for Axis 2 (X-Axis) during non-scored time 
34. Axis 3 Counts Non-Scored - Sum of counts for Axis 3 (Z-Axis) during non-scored time 
35. Axis 1 Counts Total - Sum of counts for Axis 1 (Y-Axis) during scored and non-scored time 
36. Axis 2 Counts Total - Sum of counts for Axis 2 (X-Axis) during scored and non-scored time 
37. Axis 3 Counts Total - Sum of counts for Axis 3 (Z-Axis) during scored and non-scored time 
38. Axis 1 Average Counts Scored - Average of counts for Axis 1 (Y-Axis) during scored time 
39. Axis 2 Average Counts Scored - Average of counts for Axis 2 (X-Axis) during scored time 
40. Axis 3 Average Counts Scored - Average of counts for Axis 3 (Z-Axis) during scored time 
41. Axis 1 Average Counts Non-Scored - Average of counts for Axis 1 (Y-Axis) during non-scored time 
42. Axis 2 Average Counts Non-Scored - Average of counts for Axis 2 (X-Axis) during non-scored time 
43. Axis 3 Average Counts Non-Scored - Average of counts for Axis 3 (Z-Axis) during non-scored time 
44. Axis 1 Average Counts Total - Average of counts for Axis 1 (Y-Axis) during scored and non-scored time 
45. Axis 2 Average Counts Total - Average of counts for Axis 2 (X-Axis) during scored and non-scored time 
46. Axis 3 Average Counts Total - Average of counts for Axis 3 (Z-Axis) during scored and non-scored time 
47. Axis 1 Max Counts Scored - Maximum count value for Axis 1 (Y-Axis) during scored time 
48. Axis 2 Max Counts Scored - Maximum count value for Axis 2 (X-Axis) during scored time 
49. Axis 3 Max Counts Scored - Maximum count value for Axis 3 (Z-Axis) during scored time 
50. Axis 1 Max Counts Non-Scored - Maximum count value for Axis 1 (Y-Axis) during non-scored time 
51. Axis 2 Max Counts Non-Scored - Maximum count value for Axis 2 (X-Axis) during non-scored time 
52. Axis 3 Max Counts Non-Scored - Maximum count value for Axis 3 (Z-Axis) during non-scored time 
53. Axis 1 Max Counts Total - Maximum count value for Axis 1 (Y-Axis) during scored and non-scored time 
54. Axis 2 Max Counts Total - Maximum count value for Axis 2 (X-Axis) during scored and non-scored time 
55. Axis 3 Max Counts Total - Maximum count value for Axis 3 (Z-Axis) during scored and non-scored time 
56. Axis 1 CPM Scored - Counts Per Minute for Axis 1 (Y-Axis) during scored time 
57. Axis 2 CPM Scored - Counts Per Minute for Axis 2 (X-Axis) during scored time 
58. Axis 3 CPM Scored - Counts Per Minute for Axis 3 (Z-Axis) during scored time 
59. Axis 1 CPM Non-Scored - Counts Per Minute for Axis 1 (Y-Axis) during non-scored time 
60. Axis 2 CPM Non-Scored - Counts Per Minute for Axis 2 (X-Axis) during non-scored time 
61. Axis 3 CPM Non-Scored - Counts Per Minute for Axis 3 (Z-Axis) during non-scored time 
62. Axis 1 CPM Total - Counts Per Minute for Axis 1 (Y-Axis) during scored and non-scored time 
63. Axis 2 CPM Total - Counts Per Minute for Axis 2 (X-Axis) during scored and non-scored time 
64. Axis 3 CPM Total - Counts Per Minute for Axis 3 (Z-Axis) during scored and non-scored time 
65. Vector Magnitude Counts Scored - Vector Magnitude of all 3 Axis during scored time 
66. Vector Magnitude Counts Non-Scored - Vector Magnitude of all 3 Axis during non-scored time 
67. Vector Magnitude Counts Total - Vector Magnitude of all 3 Axis during scored and non-scored time 
68. Vector Magnitude Average Counts Scored - Average Vector Magnitude of all 3 Axis during scored time 
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69. Vector Magnitude Average Counts Non-Scored - Average Vector Magnitude of all 3 Axis during non-
scored time 

70. Vector Magnitude Average Counts Total - Average Vector Magnitude of all 3 Axis during scored and non-
scored time 

71. Vector Magnitude Max Counts Scored - Maximum Vector Magnitude of all 3 Axis during scored time 
72. Vector Magnitude Max Counts Non-Scored - Maximum Vector Magnitude of all 3 Axis during non-scored 

time 
73. Vector Magnitude Max Counts Total - Maximum Vector Magnitude of all 3 Axis during scored and non-

scored time 
74. Vector Magnitude CPM Scored - Vector Magnitude Counts Per Minute during scored time 
75. Vector Magnitude CPM Non-Scored - Vector Magnitude Counts Per Minute during non-scored time 
76. Vector Magnitude CPM Total - Vector Magnitude Counts Per Minute during scored and non-scored time 
77. Steps Counts Scored - Sum of Step Counts during scored time 
78. Steps Counts Non-Scored - Sum of Step Counts during non-scored time 
79. Steps Counts Total - Sum of Step Counts during scored and non-scored time 
80. Steps Average Counts Scored - Average Step Counts during scored time 
81. Steps Average Counts Non-Scored - Average Step Counts during non-scored time 
82. Steps Average Counts Total - Average Step Counts during scored and non-scored time 
83. Steps Max Counts Scored - Maximum Step Counts during scored time 
84. Steps Max Counts Non-Scored - Maximum Step Counts during non-scored time 
85. Steps Max Counts Total - Maximum Step Counts during scored and non-scored time 
86. Steps Per Minute Scored - Steps Per Minute during scored time 
87. Steps Per Minute Non-Scored - Steps Per Minute during non-scored time 
88. Steps Per Minute Total - Steps Per Minute during scored and non-scored time 
89. Lux Average Counts Scored - Average Lux Value during scored time 
90. Lux Average Counts Non-Scored - Average Lux Value during non-scored time 
91. Lux Average Counts Total - Average Lux Value during scored and non-scored time 
92. Lux Max Counts Scored - Maximum Lux Value during scored time 
93. Lux Max Counts Non-Scored - Maximum Lux Value during non-scored time 
94. Lux Max Counts Total - Maximum Lux Value during scored and non-scored time 
95. Number of Epochs Scored - Number of epochs during scored time 
96. Number of Epochs Non-Scored - Number of epochs during non-scored time 
97. Number of Epochs Total - Number of epochs during scored and non-scored time 
98. Time Scored - Length of scored time 
99. Time Non-Scored - Length of non-scored time 
100. Time Total - Length of scored and non-scored time 
101. Calendar Days Scored - Number of Calendar Days during scored time 
102. Calendar Days Non-Scored - Number of Calendar Days during non-scored time 
103. Calendar Days Total - Number of Calendar Days during scored and non-scored time 
104. Wear Time Start - The start of a wear time 
105. Wear Time End - The end of a wear time 
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BATCH EXPORTING 
Results from the Data Scoring tool can be batch exported to a Microsoft Excel ® spreadsheet.  The resulting export 
will contain a full list of all subjects with corresponding Data Scoring results broken down by hours, days, and 
Summary.  Bout details and Wear Time Validation can also be exported along with a separate sheet showing which 
algorithms were used to produce the results and a “Definitions” sheet which defines all of the exported 
parameters.  

To begin the export, click the “Export” button after performing a calculation in the Data Scoring tab.  Check the 
“Create Batch View…” option as shown in Figure 51.  Select any of the desired export options and click “Export…” 

 
FIGURE 51 - DATA SCORING EXPORT OPTIONS 

Depending on the number of variables and files, the export process could take anywhere from 10 seconds to 2 
hours.   
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SLEEP ANALYSIS 
Sleep analysis can be performed on any dataset to determine sleep efficiency and other sleep statistics that may 
indicate sleep problems.  Any combinations of the various initialization modes are allowed for a given dataset file 
(activity, dual-axis, steps and heart rate).  ActiLife will attempt to re-integrate data collected at epoch intervals less 
than 60 seconds as all scoring is performed using 60 second epoch cycles.  

To begin scoring a dataset, click the “Select Dataset” option from the top of the Sleep Scoring tool and browse to 
an .agd file that contains data collected during sleep episodes.  Graphs of each day in the dataset will appear in the 
“Sleep Scoring” view. 

 
FIGURE 52 – SLEEP SCORING 

Areas on the graphs can be magnified by dragging the mouse pointer over the area of interest as shown in Figure 
53.  To return to the normal view, click the small circle in the bottom left-hand corner of the graph. 
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FIGURE 53 – GRAPHING 

MANUALLY ENTERING SLEEP TIMES 
Sleep times (time in or out of bed) can be manually entered into the Sleep Analysis tool using two different 
techniques.  To key-in sleep times, select the “Add Bed Time” button on the right of the Sleep Scoring tool.  Enter 
the subject’s exact time in bed and time out of bed and click “ok.”  The selected time slot will be highlighted in 
translucent red on the graph.   

Sleep times can also be added directly on the graph itself by clicking anywhere on the graph and using the arrow 
keys to navigate to the sleep episode start time.  Once a suitable start time is located, right-click anywhere on the 
graph and choose “Add New In Bed Time Here” This will mark the start of the sleep episode.  Repeat this process 
and choose “Accept Out Of Bed Time” to mark the end of the sleep episode.  Figure 54 illustrates this process. 

 

 
FIGURE 54 – MARKING SLEEP EPISODES GRAPHICALLY 

AUTOMATICALLY ENTERING SLEEP TIMES 
ActiSleep+ users can automatically estimate bed times (Time in Bed [TOB] and Time Out of Bed [TOB]) in ActiLife 
by pressing the “Detect Sleep Periods” button.  ActiLife will estimate bed times for the current data set and apply 
the selected algorithm to those bed times.   
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FIGURE 55 - AUTO SCORE SLEEP TIMES 

The Auto Score feature will not ignore non-wear times (as estimated by the Wear Time Validation tool), but the 
algorithm is designed to ignore gaps in the sleep data as shown in Figure 56. 

 
FIGURE 56 - AUTO SCORE IGNORES PERIODS WHEN DEVICE WAS REMOVED 

EDITING AUTO SCORED TIMES 
The bed times estimated by the Auto Score feature can be easily adjusted by right-clicking on the sleep period of 
interest, choosing “Adjust Out Bed Time” (or “Adjust In Bed Time”), using the left or right arrow keys on the 
keyboard to adjust the time, then right-clicking anywhere on the graph and selecting “Finished Entering Bed 
Times”.  This is illustrated in Figure 57. 



  
 

Page | 64 
 70 North Baylen Street, 

Suite 400 
 

Pensacola, FL  32502 tel 850.332.7900 
 

 +1.877.497.6996  
(Toll Free) 

 
 

  

FIGURE 57 - ADJUSTING BED TIMES 

Important: The Auto Score can only be used with data collected from 
ActiSleep+ devices.  The feature can be enabled for data collected from other 
ActiGraph devices for a small fee.  Contact support@theactigraph.com for 
more information. 

REMOVING SLEEP TIMES 
Sleep periods can be removed by right-clicking on them on the graph and choosing “Delete Current Sleep Period.”  
To delete all of the sleep periods for a particular day or for the entire dataset, choose the proper corresponding 
option (“Delete All Sleep Periods in this Day” or “Delete All Sleep Periods for the Dataset”).  Sleep periods can also 
be removed by selecting the sleep period in the list to the right and clicking the “Remove” button below the list. 

  



  
 

Page | 65 
 70 North Baylen Street, 

Suite 400 
 

Pensacola, FL  32502 tel 850.332.7900 
 

 +1.877.497.6996  
(Toll Free) 

 
 

ACTIVITY AND LUX SCALE 
The “Activity Scale” and “Lux Scale” settings below the sleep graphs adjust the maximum scale shown for Activity 
and Lux counts on the sleep graphs.  Changing the value scales all of the graphs simultaneously. 

CHANGING GRAPH COLORS 
Graph colors for activity, lux, the sleep score period, and the score indicator can be changed easily by clicking the 
color palette beside the corresponding item and choosing a different color as shown in Figure 58.  Note that the 
“Period Color” is translucent and may appear slightly lighter than its selected color. 

 
FIGURE 58 – COLOR PALETTE FOR SLEEP SCORING GRAPH 

LUX 
Lux, or ambient light, is measured by ActiGraph’s ActiSleep+ monitor, the ActiTrainer and the GT3X+ devices.  
Ambient light may affect subject sleeping habits and thus is a useful tool in analyzing circadian rhythms and 
sleeping patterns.  If lux data was recorded by the ActiGraph device, it will appear in yellow on the sleep graphs as 
shown below in Figure 59.  The lux data can be hidden by deselecting the “Show LUX data” option at the bottom of 
the screen.  Details regarding the significance of the lux values are revealed by hovering the mouse pointer over 
the “Lux Info” link at the bottom of the screen as shown in Figure 60. Note that these levels are only estimates and 
are not meant for exact interpretation of the light detected by the device. 

 



  
 

Page | 66 
 70 North Baylen Street, 

Suite 400 
 

Pensacola, FL  32502 tel 850.332.7900 
 

 +1.877.497.6996  
(Toll Free) 

 
 

 

FIGURE 59 – LUX DATA OVERLAY ON SLEEP GRAPHS 

 

  
FIGURE 60 – LUX THRESHOLDS 

SLEEP SCORING ALGORITHMS 
The Sleep Analysis tool comes standard with two validated algorithms (Sadeh 1or Cole-Kripke2) to determine 
minute-by-minute asleep/awake status.  These algorithms are selectable by the user and can be changed instantly 
for comparison purposes.  The algorithms are described below.  Select the desired algorithm by choosing it from 
the “Algorithm” drop-down menu at the top right-hand corner of the Sleep Analysis tool.  More information is 
available about the origin of the algorithms by clicking “Sleep Algorithm Information” link below the algorithm 
dropdown menu. 

  

 
1 “Automatic Sleep/Wake Identification From Wrist Activity”, Roger J. Cole, Daniel F. Kripke, etal, Sleep 12(5):461-469, 1992 American Sleep 
Disorders Association and Sleep Research Society 
2 “Activity-Based Sleep-Wake Identification: An Emprical Test of Methodological Issues”, Avi Sadeh, K.M. Sharkey and M. A. Carskadoon, 
Sleep17(3): 201-207, 1994 American Sleep Disorders Association and Sleep Research Society 
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COLE-KRIPKE ALGORITHM 
The Cole-Kripke algorithm is considered appropriate for use with adult populations because it was developed using 
subjects ranging from 35 to 65 years of age.  Roger J. Cole and Daniel F. Kripke adapted a scoring method 
developed by J. B. Webster with an experimental wrist actigraph for the AMI actigraph in 1992.  It was developed 
using 10, 30 and 60 epochs, with the highest level of accuracy resulting from data collected at 10 second epoch 
periods. 

The algorithm was adapted to the ActiGraph ActiSleep monitor by performing a side by side test using the AMI 
device and the ActiSleep monitor worn together.  The data were scaled then put through the algorithms until the 
ActiSleep monitor sleep score matched that from the AMI device. 

SADEH ALGORITHM SUMMARY 
The Sadeh algorithm was developed by Dr. Avi Sadeh from Tel-Aviv University in Israel and is considered 
appropriate for younger populations because it was developed using subjects ranging from 10 to 25 years of age.  
He used the same device that Cole-Kripke used to develop their algorithm, and ActiGraph therefore adapted it in 
the same way by scaling our data until it matched up with the scoring results of the AMI device.  In general terms, 
this algorithm determines a subject’s sleep state by examining the ActiGraph activity over an 11 minute sliding 
window.  For any given window, a “Sleep Score” (whether the person is asleep or not) can be determined by 
applying this formula.  After selecting a sleep time (Time In Bed (TIB) and Time Out of Bed (TOB)) each minute of 
sleep data is analyzed this way.   

CUSTOM SLEEP ALGORITHMS 
ActiSleep+ customers can create their own custom sleep scoring algorithm that uses the same “sliding window” 
concept as the Sadeh and Cole-Kripke algorithms.  To get started, choose “Create New” from the Algorithm 
dropdown menu.   

 
FIGURE 61 - CUSTOM SLEEP ALGORITHM 

The Custom Sleep Scoring Parameters form shown in will load.   
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FIGURE 62 - CUSTOM SLEEP SCORING DESIGN FORM 

This tool will allow users to customize the following settings. 

ALGORITHM NAME 
The Algorithm Name is the name that will appear in the drop-down menu after the algorithm design is complete. 

EPOCH WINDOW 
The sliding window technique works as follows: All epochs in a given dataset are scanned.  Each epoch of data 
receives a sleep or a wake score based on its count level as well as the count levels of other epochs before and 
after itself.  This “window” of epochs and surrounding epochs then “slides” to the next epoch (and surrounding 
epochs) and the process repeats. 

The Epoch Window defines the sliding window and the weighting which is given to the current and surrounding 
epochs in order to determine whether to score the current epoch as sleep or wake.  To increase the size of the 
window, adjust the “Epochs to use before current” and “Epochs to use after current” options; the graphic will 
increase or decrease in width automatically.   
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FIGURE 63 - CUSTOM SLEEP SCORE EPOCH WINDOW 

Adjust the numbers below the surrounding epochs to change the weighting.  Change the Wake Threshold in the 
Count Parameters section to adjust the comparison level.  The Sleep/Wake formula at the bottom of the Custom 
Sleep Algorithm tool shows the formula used to determine whether the current epoch (epoch-0) is scored as wake 
or sleep.  In the formula show in Figure 64, the current epoch will be scored as wake if the formula is greater than 
or equal to 10. 

 
FIGURE 64 - SLEEP/WAKE FORMULA 

COUNT PARAMETERS 
Wake Threshold – This is the value which the sliding window is compared to in order to determine sleep or wake 
status for epoch-0 

Data to Use: Users have the option of using Axis 1, Axis 2, or Axis 3 data to calculate the custom sleep score.  
Alternatively, the Vector Magnitude (VM) of all 3 axes can be used. 

Set Maximum Value of Count – Use this option to put a limit on the maximum weight a particular epoch can have 
on the sleep/wake formula.  For instance, if (epoch-2)*0.05 = 500 (see Figure 64), setting the Maximum Value of 
Count to 300 would actually limit that epoch’s contribution to 300 (rather than 500). 

Epoch Length Required – This option allows users to specify a required epoch length for datasets using the new 
customized formula.  Datasets that do not meet this requirement cannot be used – ActiLife will automatically 
attempt to reintegrate lesser epoch sized datasets up to the required epoch length. 

PORTABILITY OF THE CUSTOM SLEEP ALGORITHM 
Once the custom algorithm has been written, it can be shared with other ActiLife users.  Simply run the custom 
algorithm against an *.agd dataset to produce the Sleep Score Information for that dataset.  That *.agd will then 
contain the custom sleep score algorithm.  Whenever the *.agd file is shared with other users, this algorithm will 
automatically appear in their algorithm dropdown menu in the Sleep Analysis tool. 
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Important: The Custom Sleep Algorithm tool can only be used with data 
collected from ActiSleep+ devices.  The feature can be enabled for data 
collected from other ActiGraph devices for a small fee.  Contact 
support@theactigraph.com for more information. 

SLEEP SCORE INFORMATION 
Both algorithms will yield the following information within ActiLife’s Sleep Scoring tool for each sleep period.  Sleep 
period scores can be seen by clicking on the sleep period of interest on the right-hand side of the screen (see 
Figure 52 for an illustration). 

Sleep Onset - The first minute that the algorithm scores “asleep.” 

Total Sleep Time (TST) – The total number of minutes scored as “asleep.” 

Wake after Sleep Onset (WASO) – The total amount of time a subject is awake during a sleep period, minus the 
sleep latency. 

Awakenings - The number of different awakening episodes as scored by the algorithm.  This is sometimes referred 
to as Frequency of Awakenings (shown as the number of awakenings per night). 

Avg Awakening – The average length, in minutes, of all awakening episodes. 

Total Counts – The total actigraphy counts summed together for the entire sleep period. 

Efficiency – Number of sleep minutes divided by the total number of minutes the subject was in bed (i.e., the 
difference between the In-Bed and Out Bed time).  

ACTOGRAM VIEW 
The ActoGram view option provides ActiSleep + users with the ability to quickly discern circadian patterns in sleep 
behavior by scaling and compressing the sleep graphs.  Enable the ActoGram view by choosing the radio button 
corresponding to this view at the bottom of the Sleep Scoring tool.  Figure 65 illustrates an ActoGram view. 

Several options exist for editing the ActoGram view.   

Show 6 Hour Ticks – This option will toggle the periodic 6 hour hash marks on the ActoGram graph. 

Show Hourly Ticks – This option will toggle the periodic hourly hash marks on the ActoGram graph. 

Graphs Per Page – Use this option to compress or expand the ActoGram view vertically. 

Lux – This check box toggles the ambient light data on the ActoGram view (in yellow) 
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FIGURE 65 – ACTOGRAM VIEW 

SAVING THE ACTOGRAM 
The ActoGram can be saved as a sharable image by clicking “Save ActoGram” at the bottom of the graph.  This 
option will give the user the option to export the ActoGram to a .jpg image for sharing.   

Important: The ActoGram view can only be used with data collected from 
ActiSleep+ devices.  The feature can be enabled for data collected from other 
ActiGraph devices for a small fee.  Contact support@theactigraph.com for 
more information. 

SHOW SLEEP EPOCHS 
Clicking the “Show Sleep Epochs” button will load a matrix of each epoch in the dataset with details about whether 
the epoch was scored as a “Sleep Epoch” (indicated by an “S”) or a “Wake Epoch” (indicated by a “W”).  This list 
can be exported to CSV by clicking “Save” at the bottom of the form or by copying and pasting the values. In 
addition, the entire list can be copied to the clipboard by clicking the corresponding button – the list can then be 
pasted into any text editor. 
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SAVE SLEEP REPORT 
Sleep scores produced in the Sleep Scoring tab can be exported to either a CSV or PDF file by clicking the “Save 
Sleep Report” option at the bottom right-hand side of the screen.  Select the desired output from the options 
dialog that appears.  Browse to the export location, type a file name, and click “Save” to begin the export. 

  
FIGURE 66 – SAVE SLEEP REPORT DIALOG 
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HEART RATE DATA EXTRACTION FROM LEAP 
In order to calculate heart rate, heart rate variability and cardiac rhythms, the following steps must be performed:  

1. Initialize a Leap device to collect raw accelerometer and ppg data. The Heart Rate program will 
synchronize data from accelerometer and PPG sensors. Sampling accelerometer data at 32Hz is sufficient.  

 
2. Collect data from the Leap device. 
3. Download data from the Leap device. This file will be in .agsd format. The default download directory is 

Documents\ActiGraph\ActiLife\Downloads. 
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4. Convert the agsd file to raw csv files. You will get a ppg.csv file, alongside a raw.csv file. 

 
5. Do NOT resample the accelerometer data (this is deselected by default) 
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6. You now have a raw accelerometer data csv (“RAW.csv”), and a raw PPG data csv (“ppg.csv”). These will 

both be utilized in our command prompt to retrieve heart rate data. 
7. Open your command prompt by either searching “Command Prompt” in your windows search, or by using 

the WIN+R shortcut and then entering “cmd” before clicking OK. 

8.  
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9. Enter the hr.exe file directory into the command prompt first to make sure we are utilizing the heart rate 
program (do not run it yet).

  

10. Enter the file directories for both the raw accelerometer data file (use –a) “RAW.csv” and the raw PPG 
data file (use –p) “ppg.csv”, then dictate your time zone (use –z).

 

11. Lastly, enter the program(s) that you want to run, choosing their output directory and output filenames. A 
list of programs can be found later. In this screenshot, we will run IBI endpoints as an example. 

 
12. Press Enter to execute the algorithm. 

Examine the output files. By default, they are located in the folder from where the algorithm is executed. The files 
can be viewed in, for example, Excel. 
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HEART RATE ALGORITHM 
The heart rate command line programs allow measuring heart rate, heart rate variability and cardiac rhythm from 
accelerometer and green PPG data collected using a LEAP device. This program can be downloaded from the 
ActiGraph Website’s ActiLife page after entering the appropriate ActiLife 7 License Key. 

GRAPHICAL USER INTERFACE 
The graphical user interface allows the analysis of one set of accelerometer and PPG csv files. Double click on the 
program to run it. You will be presented with the interface shown in the following figure. 
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You can select input files for both accelerometer and PPG data. Then, choose a folder where output files will be 
created. Finally. Select a timezone from the list of available timezones. You can type part of the timezone’s name 
(e.g. “Central” for “US/Central”) to narrow down the list. 

Clicking on start will start the process and output files will be visible in the selected target folder. 

COMMAND LINE CLIENT 
The program can be run from the command line. In order to access the command line on a computer running 
Microsoft Windows, you can press and hold the Windows key, and press R. Then, type cmd and press enter. You 
can run the program by typing in its full path. 

The following parameters are supported: 

Short name Long name Description Default value 
-a --accel-input-path Accelerometer Input file 

path 
NA 

-p --ppg-input-path PPG Input file path NA 
-z --timezone Timezone UTC 
-s --show-dates Show dates in the output 

files. If set to False, only 
time and day-of-the-
week data is shown. 

True 

-e --hr-output-filename-epochs Heart Rate Output file 
name 

HeartRate.csv 

-d --hr-output-filename-days Heart Rate Daily 
Aggregations Output file 
nam 

HeartRateDays.csv 
 

-u --hrv-output-filename-epochs Heart Rate Variability 
Output file name 

HeartRateVar.csv 

-v --hrv-output-filename-days Heart Rate Variability 
Daily Aggregations 
Output file name 

HeartRateVarDays.csv 

-b --cr-output-filename-epochs Cardiac Rhythm Output 
file name 

CardiacRhythm.csv 

-c --cr-output-filename-days Cardiac Rhythm Daily 
Aggregations Output file 
name 

CardiacRhythmDays.csv 

-i --ibi-output-filename Inter-beat Interval 
Output file name 

InterBeatInterval.csv 
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The list of available parameters can also be seen using the --help switch. The version of the tool can be seen 
using the –version switch 

The program expects two csv files to be provided as inputs. One file must contain raw accelerometer data 
exported from ActiLife. The other must contain raw green PPG data, also expected from ActiLife. Both files need to 
be formatted as CSV files. 

The command line tool needs to read both files into memory before it can process them and will need to align and 
resample the data. Because of this, it needs generous amounts of RAM. A computer with at least 32 GB of RAM is 
recommended to be able to process large files. 

PLM ANALYSIS 
The Periodic Leg Movement (PLM) tool allows users to detect and score periodic leg movements in patients with 
PLM disorder or restless leg syndrome.  Note: The PLM tool is only compatible with data collected from the legacy 
ActiSleep or the new ActiSleep+ monitor devices.  This analysis serves as a cost-effective alternative to 
polysomnography (PSG) analysis. 

Note: ActiGraph is working with leading sleep institutions to obtain research-
backed validation on the PLM Analysis tool.  However, at this time, the PLM 
analysis uses existing research to make estimates on the presence of PLM in 
patients. 

INITIALIZING DEVICES FOR PLM ANALYSIS 
To use the tool, initialize an ActiSleep monitor through the devices tab to start collecting data at the desired 
time.  (Info about ActiSleep battery life) ActiSleep+ devices only have one option for initialization (30Hz).  Legacy 
ActiSleep devices should be initialized to collect data at 1s epochs.  During initialization, ActiLife gives users the 
option to print a sleep diary.  The sleep diary can be used by patients who choose to wear the devices for several 
nights in their own homes or for doctors who are logging multiple patients' sleep behaviors.   Patients should be 
instructed to use the sleep diary to keep track of the time in bed (TIB) and time out of bed (TOB) for purposes of 
analysis. 

Attach the ActiSleep monitor to the top interior of the patient’s left and right feet around the ball of the foot as 
shown in the image below.  This can be accomplished with bandage wrapping or with straps available from 
ActiGraph.  Patients should wear the device during the entire duration of their total time in bed. 
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FIGURE 67 - WEAR LOCATION FOR PLM ANALYSIS 

DOWNLOADING DEVICES 
After patients have worn the devices for the desired number of sleep periods, collect the devices and download 
them using the Devices tab.  Legacy ActiSleep monitors will produce an *.agd file on download.  This file can be 
used for scoring PLM in the PLM tab.  ActiSleep+ devices will create a *.gt3x file on download.  This file contains 
the raw acceleration data collected by the devices and needs to be post-processed (i.e., converted to *.agd format) 
prior to PLM scoring.  This can be accomplished by choosing “Create AGD File” from the download dialog as shown 
in the figure below.  Select 1s epoch and 3 axes.  The other options are optional, but “Low Frequency Extension” 
should not be selected. 

 

FIGURE 68 - DOWNLOAD SETTINGS FOR PLM ANALYSIS 

 After download, an AGD file will be created in the download folder which is also selected at the time of download. 

SCORING THE PLM DATA 
To score periodic leg movements, open the PLM tab and select the left and right leg *.agd files.  Click the “Add 
Sleep Periods” button and select the entry method.  

 Add Period Using Bed Times – Use this option to manually enter in times as recorded by the doctor or 
patient on the sleep diary. 

 Import from Separate AGD File – Use this option to import sleep times from another AGD file that already 
contains the same sleep times. 

 Enter Period Graphically – Coming soon.  

Select which axis or axes to use to score the PLM data.  The Vector Magnitude option combines all three axes using 
the vector magnitude formula.  See Appendix B – Vector Magnitude for more information.   

Select the thresholds for detecting legitimate “movement”.   
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Note: these thresholds only set the level at which PLM activity 
occurs.  ActiLife’s built-in algorithm determines whether or not the movement 
qualifies as PLM. 

 Onset Threshold – The threshold (in counts-per-epoch) at which PLM movement detection starts 
 Decay Threshold – The threshold (in counts-per-epoch) at which PLM movement detection ends. 

Onset and decay thresholds are available to introduce hysteresis into the movement detection. 

INTERPRETING THE PERIODIC LIMB MOVEMENT OUTPUT 
After scoring files for Periodic Leg Movement, click on the different sleep periods to view the graph and PLM stats 
for each sleep period.    

GRAPHS 
Clicking on a sleep period will load a PLM score graph.  The green background represents the total time in bed 
(sleep period) as logged by the user.  The graph will automatically show data 1 hour before the time in bed and 1 
hour after the time out of bed.  The blue horizontal line represents the onset threshold and the red horizontal line 
represents the decay threshold.  The bar graph below the main activity graph gives users a quick reference to PLM 
bouts (bouts of activity that meet the qualifications of Periodic Leg Movement).  Both graphs can be zoomed in or 
out simultaneously by dragging the mouse over the area of interest.  To zoom back out, click the small circle in the 
lower left-hand corner of the graph until the desired zoom level is achieved. 

STATS 
 PLMI (per hour) - PLMI stands for Periodic Leg Movement Indices.  This value represents the number of 

qualifying periodic leg movements per hour, averaged over the entire sleep period. 
 Minutes of PLM Kicks - The total number of minutes of "kicks" or activity spikes that exceed the onset 

threshold AND the total minutes of consecutive "kicks" thereafter that exceed the decay threshold. 
 Number of PLM Kicks - The number of "kicks" or activity spikes that exceed the onset threshold AND the 

number of consecutive "kicks" that exceed the decay threshold. 
 Number of PLM Bouts - A count of the number of bouts of PLM that occurred during the selected sleep 

period. 
 Average PLM Bout Length (min) - The average length, in minutes, of all of the PLM bouts for the selected 

sleep period. 
 Minutes of PLM Bouts - The total time, in minutes, of PLM bouts.  This time is different from the PLM kicks 

because kicks do not necessarily qualify as valid PLM. 
 Avg PLMS Intensity - The average intensity of the PLM during Sleep of all of the PLM bouts.  Essentially, 

this is the duty cycle of all PLM bouts.  Avg PLMS Intensity = total minutes of valid PLM / total PLM bout 
length 

For more information regarding the source of our PLM calculations, see our online FAQ, "How were the Periodic 
Leg Movement algorithms derived?". 
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GRAPHING 
ActiLife’s graphing tab allows users to quickly see graphs of each day in a given dataset.  Click “Select Dataset” and 
browse to an .agd file containing data.  The graphs will load vertically and will be ordered from latest to most 
recent date, ascending downward.  Zooming is accomplished by dragging the mouse over the area of interest as 
shown in Figure 53.  Graphs can be reset by clicking the small icon in the bottom left-hand corner of the graph 
which is also illustrated in Figure 53. 

EXPORTING 
Graphs can be exported to a PDF by clicking “Export to PDF” in the top right corner of the Graphing tab.  Selecting 
“Keep any zoom information” will output the graph with the current zoom view (if any).  Individual days can be 
exported to pdf by checking or unchecking the days in the Export dialog. 

  
FIGURE 69 – GRAPHING EXPORT DIALOG 

MODE OPTIONS 
The “Mode Options” section to the right of the graphs gives users the ability to add or remove data items and 
change the color of various items on the graphs.  If a dataset contains three-axis activity information (i.e., if the 
device was set to collect three-axis data upon initialization), all three axes will be available for selection (not 
disabled) in the “Mode Options” section.  Deselecting any axis will remove it from the graph view.  Multiple axes 
can be enabled simultaneously; however, in order to avoid cluttering the graph view, only one alternative data 
point can be shown simultaneously with activity data.  To enable Steps, Heart Rate, Lux, or Inclination, select the 
radio button corresponding to the correct data point.  A legend explaining the meaning of each data point will 
appear below the “Mode Option” section when a given data point is selected as shown in Figure 70.  Axis values 
can be scaled by entering new values into the activity scale boxes to the right of the graphs. 

Parameter graph colors can be selected by clicking the palette icon to the right of the variable of interest and 
choosing the desired color.  The graph will immediately update with the new color. 
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FIGURE 70 – GRAPH LEGENDS 

AXES SCALING 
Unless specified, each day shown in the graphing area is scaled individually according to the maximum values 
collected on that day.  By checking the “Equal Scales” option on the right, all activity graphs will be scaled evenly 
according to the number in the scale box.  These scale boxes can be seen in Figure 70. 

INCLINOMETER 
The inclinometer tool can be used to detect positional information when any 3 axis device is worn on the waist or 
thigh.  Thigh-worn devices are inherently better at detecting sedentary (sitting/lying) versus non-sedentary 
(standing/stepping) than are waist-worn devices. 

If an *.agd dataset contains no inclinometer data, a message similar to the one shown in Figure 71 will appear.  To 
utilize the inclinometer tool, select “Inclinometer” when initializing a GT3X or when creating an *.agd file from a 
GT3X+ device.  It is important that the device wear-location be specified for any *.agd file.  To edit the wear 
location, open the *.agd file in the AGD File Viewer and edit the biometric information; update the “Limb” to be 
either “Waist” or “Thigh”.   

Note: Only Waist and Thigh worn devices can be used with the Inclinometer 
tool 
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FIGURE 71 - FILE WITH NO INCLINOMETER DATA 

Once an appropriate file has been loaded, the Inclinometer tool will display a breakdown of hourly positional 
information as shown in Figure 72.  The calendar on the right can be used to navigate among days in the dataset to 
quickly jump to an area of interest.  Any notes written in the Notes area will be stored with the *.agd file and will 
be available in the PDF report and in any subsequent interaction with the Inclinometer tool for that particular file. 
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FIGURE 72 - INCLINOMETER OUTPUT 

 

Note that the graph colors can be changed by using the color palette on the right hand side as well. 

CREATING AN INCLINOMETER REPORT 
A PDF report of the Inclinometer output can be created by clicking the “Export to PDF…” button.  Users will be 
given the option to choose which days to export to the report. 

Important: The inclinometer feature was designed by the ActiGraph 
engineering team as a viable way to detect user positional trends over a 
period of time.  The thigh worn algorithm is best suited for positional 
detection as it is difficult to algorithmically determine the difference between 
sitting and standing for waist-worn devices.  For more information about the 
waist-worn inclinometer algorithm, see our Inclinometer White Paper. 
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DATA COMPARISON 
The Data Comparison tool allows users to compare ambulatory activity data collected during private studies with 
other public activity datasets that were generated from ActiGraph devices.  At the time of this writing, data 
comparison cam be made against public dataset – the 2002-2003 and 2003-2004 National Health and Nutrition 
Examination Survey (NHANES) collected by the Center for Disease Control and Prevention.  More information 
about this dataset can be found at http://www.cdc.gov/nchs/nhanes/about_nhanes.htm. 

The goal of the data comparison tool is to provide ActiLife users with the ability to objectively compare their own 
actigraphy data with that of national or world-wide standards in an effort to understand correlations among the 
datasets.  As more datasets become available, ActiLife will continue to expand this offering, eventually providing 
various disease research study information and chronic illness baseline data.   

LOADING DATASETS FOR COMPARISON 
As datasets are added to the Wear Time Validation and Data Scoring tools, they are automatically loaded into the 
Data Comparison tool.  To view these datasets (or to load more), click the “Load/Edit Subjects…” button at the top 
of the Data Comparison grid.  A form similar to the one shown in Figure 73 will appear.  Rows highlighted in red 
indicate that more metadata information is required in order to fully compare this user to the other users in the 
baselines database(s).  In the example shown in Figure 73, the user shown in red will be compared on all 
parameters except for weight.  That is, three females and three males will appear in the gender comparison, but 
only five users will be compared in the weight category. 

 

  
FIGURE 73 – DATA COMPARISON SUBJECT FORM 

Once all edits are complete, click “Save and Close” from the subject form.   
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SELECTING NHANES COMPARISONS 
The NHANES Data Filter allows the user to set comparison parameters.  To compare the user dataset to only males 
in the NHANES data population, select “Male” from the Gender dropdown.  To set a custom age range for 
comparison, choose “Custom” from the Age dropdown and type in a custom age range to compare against.  Use 
this process for all of the filter parameters until the desired comparisons are set.  To apply the same filter 
parameters to the user dataset, check the box “Apply Filter to Your AGD Files”.  This will force ActiLife to use only 
those datasets that meet the filter qualifications from both the NHANES data and the user’s local data.   

  
FIGURE 74 - NHANES AND SUBJECT DATA FILTER 

The results of the filter will be summarized below the Data Filter section as shown in Figure 75.   

  
FIGURE 75 - FILTER RESULTS 

Click “Calculate” to run the comparison.  Once the calculation is complete, the resultant graphs will appear on the 
right-hand side.  Use the “Select Graphs” options to turn specific graphs on or off.  Double-click on any graph to 
make it larger.  These graphs show comparison between the user’s data and the NHANES data set.  Double click 
the graph again to return to the normal view. 
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FIGURE 76 - ENLARGED AGE COMPARISON GRAPH 

EXPORTING DATA COMPARISON RESULTS 
To export the graphical results of the comparisons, click the “Export” button in the lower right-hand corner of the 
Data Comparison tool.  Select a location and a file name and click “Save.”  This will generate a printable/shareable 
PDF document of the Data Comparison tool’s graphic results. 

DATA VAULT 
The Data Vault tool is a secure, cloud-based storage system integrated into the ActiLife program that allows users 
to quickly and securely save files into their own personal cloud to share with others.  There are many immediate 
benefits to the Data Vault system including: 

 Simplified Data Sharing 
 Reduced IT costs 
 Built-in data backup and retention 
 Fast storage 
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FIGURE 77 - ACTILIFE DATA VAULT 

LIMITATIONS ON THE DATA VAULT 
The Data Vault is not FIPS compliant and it is not possible to upload to Data Vault from a FIPS enabled machine. 
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ADDING FILES TO THE DATA VAULT 
ActiLife 7 users receive 4GB of free space.  To add files to the Data Vault, navigate to the Data Vault tab and click 
the “Add File(s)” button.  Browse to the file location and select the files you wish to upload.  Multiple files may be 
added by holding the “Shift” key on the keyboard while selecting files.  Click “Open” to start the upload process. 

  



  
 

Page | 92 
 70 North Baylen Street, 

Suite 400 
 

Pensacola, FL  32502 tel 850.332.7900 
 

 +1.877.497.6996  
(Toll Free) 

 
 

SUB FOLDERS 
Sub folder organization in the Data Vault is available in ActiLife version 6.0 and later.  To add sub-folders, click the 
“New Folder” button in the Data Vault view.  Users who are sharing license groups between ActiLife 5 and ActiLife 
6 should be aware that ActiLife 5 users can only upload to the root directory and cannot see or utilize any 
subfolders that were created by ActiLife 6 users. 

SHARING DATA WITH COLLEAGUES – LICENSE GROUPING 
License grouping allows dispersed Data Vault users to share their valuable data quickly and easily.  ActiLife Full and 
Lite licenses are automatically grouped together.  A Lite user who uploads files using their Data Vault tab will 
automatically see any files that a Full user uploads, and vice versa.  This ensures centralization of important 
actigraphy data when that data is being collected across multiple study sites.  

Institutions and Universities can also be grouped together under a single License Group for collaboration on 
studies.  For information on License Grouping, contact ActiGraph support at support@theactigraph.com 

MULTIPART UPLOADS 
The ActiLife Data Vault takes advantage of a technology known as multipart uploads.  This technique delineates 
the files into multiple parts and uploads each part to the Data Vault.  This technique results in much faster uploads 
over slow connections and increases reliability, since failed uploads can be restarted where they left off.  For this 
reason, the Data Vault tool is superior to other methods of file sharing such as FTP, email, and network sharing.   

VIEWING UPLOAD PROGRESS 
To view the upload progress for the queued files, click on the hyperlink below the progress indicator.  This will 
open the Data Vault Transfers window.  From there, file transfers can be cancelled and status information can be 
viewed. 

 

 

FIGURE 78 - DATA VAULT TRANSFERS WINDOW 

FILE TYPES 
Any type of file can be uploaded to the Data Vault.  Simply change the file type to “All Files” in the File Upload 
dialog as shown in Figure 79. 

  
FIGURE 79 - CHANGING THE DATA VAULT FILE TYPE 
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DOWNLOADING FILES FROM THE DATA VAULT 
To download files stored in the Data Vault, simply click the ‘Download’ link to the right of the file you wish to 
download.  Multi-file downloads are not supported as of version 6.1 but are coming soon. 

PURCHASING MORE SPACE 
Various data plans are available for a monthly or yearly fee.  Contact ActiGraph sales to inquire about more space 
for your organization at sales@theactigraph.com or 1-877-497-6996. 
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APPENDIX A - FILE TYPES IN ACTILIFE 

COMPARISON OF GT3X+ AND GT3X DEVICES 
Before explaining the difference between the *.gt3x and *.agd files, it would be useful to explain the paradigm 
differences between the GT3X and GT3X+ device platforms.  GT3X devices sample accelerometer data 30Hz (only).  
This data is then filtered and accumulated into user-selected epoch sizes (60s, for instance) inside of the device.  
Because this data is being processed and accumulated into epoch-size chunks, on-board storage requirements are 
relatively small.  Whenever ActiLife downloads data from these devices, it produces an *.agd file (epoch-level file) 
which can then be processed inside of ActiLife.   

GT3X+ platform devices are different in that the user selects the rate at which raw data is sampled from the 
accelerometer (the user can choose any frequency between 30-100Hz in 10Hz increments).  The GT3X+ then stores 
every sample, making the data storage requirement for this device type much greater.  Upon download, the GT3X+ 
device produces a *.gt3x file (raw data).  The ActiLife software can then be used to band pass filter and accumulate 
that raw data into epoch-level data, thus producing an *.agd file that is equivalent to the one produced from the 
GT3X device as described above.  The benefit of the GT3X+ device is that the user can produce any epoch-level 
output from the raw data.  In addition, the raw data is available to perform other analyses outside of the scope of 
this discussion.   

Figure 80 graphically explains the difference between the GT3X and GT3X+ devices. 

 
FIGURE 80 - COMPARISON OF THE GT3X AND GT3X+ DEVICES (AND ACTILIFE'S ROLE) 

*.GT3X FILE FORMAT 
GT3X+ devices produce an interim compressed file with file extension *.gt3x.  This is a compressed file and must be 
extracted to a usable format using ActiLife’s import/export tool which is accessible from the File menu in ActiLife.  
The file can be exported to *.agd format for processing in ActiLife or *.csv/*.dat format for processing using third 
party tools.  The *.gt3x file can also be exported directly to *.agd format during the download process by checking 
“Create AGD File” from the download prompt (see Downloading GT3X+ Devices for more information). 
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*.AGSD FILE FORMAT 
LEAP devices produce an interim compressed file with file extension *.agsd.  This is a compressed file and must be 
extracted to a usable format using ActiLife’s import/export tool which is accessible from the File menu in ActiLife.  
The file can be exported to *.agd format for processing in ActiLife or *.csv/*.dat format for processing using third 
party tools.  The *.asd file can also be exported directly to *.agd format during the download process by checking 
“Create AGD File” from the download prompt. 

This file format can contain data from other sensors which cannot be processed in ActiLife. 

 

*.AGD FILE FORMAT 
The *.agd file format is ActiLife’s native file format and is the desired file type for all ActiLife operations and tools 
such as Wear Time Validation, Data Scoring, Sleep Scoring, and Graphing.  These *.agd files are database files 
formatted for use with the popular SQLite architecture (www.sqlite.org).  These files can be viewed in the ActiLife 
AGD viewer (available from the File menu).  Alternatively, the SQLite browser (publically available on the SQLite 
website) can be used to browse the details of the *.agd files.  A file schema is provided in Figure A1. 

 
FIGURE 81 - *.AGD FILE SCHEMA 

 

*.agd files are created in ActiLife immediately when data from a GT1M, GT3X, ActiTrainer, or ActiSleep device is 
downloaded through the “Devices” tab.  These *.agd files typically contain post-filtered and accumulated data as 
this is the only type of data that ActiLife can properly handle.  The rows in the database represent whole-number 
epoch summations (1s, 5s, 10s, 30s, 60s, etc.).  However, at the time of this writing all GT1M, GT3X, ActiTrainer, 
and ASM products that have been initialized to collect raw data (12Hz or 30Hz) will produce an *.agd file on 
download.  Although the file cannot be processed in ActiLife, the *.agd format can be exported to *.csv or *.dat 
through ActiLife’s import/export tool or AGD viewer tool, both accessible from the File menu. 
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GT3X+ and ActiSleep+ devices produce a *.gt3x file on download (see *.gt3x File Format).  In order to process in 
ActiLife, the file must be exported to *.agd format.  This can be done at the time of download by checking “Create 
AGD File” from the download dialog box or by using ActiLife’s built-in import/export tool available from the File 
menu. 
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Q*.AGD DATA TABLE FORMAT 
The data table in the *agd database consist of the following parameters.  Their calculations are explained. 

dataTimeStamp – a measure of total Ticks.  A single tick represents one hundred nanoseconds or one ten-millionth 
of a second. There are 10,000 ticks in a millisecond.  The value of this property represents the number of 100-
nanosecond intervals that have elapsed since 12:00:00 midnight, January 1, 0001.  More information available at 
http://msdn.microsoft.com/en-us/library/system.datetime.ticks.aspx  

axis 1 – Post filtered and accumulated per-epoch vertical activity data 

axis 2 (optional) – Post filtered and accumulated per-epoch horizontal activity data 

axis 3 (optional) – Post filtered and accumulated per-epoch perpendicular activity data  

steps (optional) – Total steps per epoch 

hr (optional) – Heart beats-per-epoch.  This data is only gathered by ActiTrainer devices when those devices are 
initialized to collect heart rate data AND when the Polar® Heart Monitor (wireless heart strap) is worn by the user. 

Lux (optional) – Ambient light sampled once per second (on GT3X+ and ASM devices only) and averaged over the 
length of the selected epoch.  (e.g., for 60s epochs, this would be the light values summed once per second and 
divided by 60). 

Inclinometer (optional) – Device orientation information.  This is calculated by sampling the angle of the device 
over the entire length of the epoch (30 times per second) and selecting the predominant angle; i.e., the angle 
“range” that appeared the majority of the time over the epoch.  For details about inclinometer functionality, see 
the Inclinometer Whitepaper. 

*.DAT FILE FORMAT 
Older versions of ActiLife produced *.dat files when downloading data from devices.  These files consist of ten (10) 
lines of header data (meta information about the content) followed by epoch accumulated/filtered data.  This 
“DAT” file stores all of the activity (1 to 3 axis), pedometer, Inclinometer, and/or heart rate data in ASCII format.  
This file also contains the Serial Number, Start Time, Start Date, Epoch Period, Download Time, Download Date, 
Current Memory Address Pointer, Current Battery Voltage, Mode and First Start Time (used to build the DAT file) 
as part of its ten (10) line header information.  The file can be viewed with any standard text editor such as MS 
Notepad. The Mode value given in the header of the DAT file outlines which features were active during data 
collection for the file.  Error! Reference source not found.Table 6 outlines the values of the Mode variable. 
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TABLE 6 - MODE WORD DEFINITIONS 
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APPENDIX B – VECTOR MAGNITUDE 
The term Vector Magnitude is used frequently throughout this manual and often when working with ActiGraph 
devices.  Vector Magnitude refers to the magnitude of the resulting vector that forms when combining the 
sampled acceleration from all three axes on any device.  Figure 82 illustrates the axes orientation for all ActiGraph 
devices. 

                                                     

FIGURE 82 - AXIS DEFINITIONS FOR ACTIGRAPH DEVICES 

When looking at epoch level data (post filtered and accumulated data), the Vector Magnitude (or VM) can be 
defined as  

𝑉𝑒𝑐𝑡𝑜𝑟 𝑀𝑎𝑔𝑛𝑖𝑡𝑢𝑑𝑒 =  𝑉𝑀 = ඥ(𝐴𝑥𝑖𝑠 1)ଶ + (𝐴𝑥𝑖𝑠 2)ଶ + (𝐴𝑥𝑖𝑠 3)ଶ 

This value can be calculated on a per-epoch basis or as a sum for all axes over time. 

 


